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Introduction

Plug-ins are special-purpose software compo-
nents that provide additional signal processing
functionality to Pro Tools.

The DigiRack plug-ins included with Pro Tools
provide a comprehensive set of digital signal
processing effects that include EQ, dynamics,
delay, and other essential functions.

Plug-In Formats

There are three formats of plug-ins:
e TDM plug-ins (real-time, DSP-based)
e RTAS plug-ins (real-time, host-based)
e AudioSuite plug-ins (non-real-time, file-
based processing)

TDM Plug-Ins
(Pro Tools HD Only)

TDM (Time Division Multiplexing) plug-ins
function as track inserts, are applied to audio
during playback, and process audio non-de-
structively in real time. TDM plug-ins are de-
signed for use with Pro Tools HD software on
Pro Tools|HD systems, and rely on the process-
ing power of Digidesign DSP cards.

The number and variety of TDM plug-ins that
you can use simultaneously in a session are lim-
ited only by the amount of DSP available. You
can increase available DSP by installing addi-
tional DSP cards (such as HD Core, HD Accel, or
HD Process cards) in your computer. This
power-on-demand aspect is a significant advan-
tage of Pro Tools|HD systems.

RTAS Plug-Ins

RTAS (Real-Time AudioSuite) plug-ins provide
features and functionality similar to their TDM
counterparts, but unlike TDM plug-ins, they rely
on and are limited by the processing power of
your computer. The more powerful your com-
puter, the greater the number and variety of
RTAS plug-ins that you can use simultaneously.

Because of this dependence on the CPU or host
processing, the more RTAS plug-ins you use con-
currently in a session, the greater the impact it

will have on other aspects of your system’s per-
formance, such as maximum track count, num-
ber of available voices, the density of edits pos-
sible, and latency in automation and recording.

RTAS plug-ins can be used on both with
Pro Tools HD, LE, and M-Powered.
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AudioSuite Plug-Ins

AudioSuite plug-ins are used to process and
modify audio files on disk, rather than non-
destructively in real time. Depending on how
you configure a non-real-time AudioSuite plug-
in, it will either create an entirely new audio file,
or alter the original source audio file. Audio-
Suite plug-ins can be used on all Pro Tools sys-
tems and Avid software.

Conventions Used in This
Guide

All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:

System Requirements

To use DigiRack plug-ins you need one of the
following:

¢ A Digidesign-qualified Pro Tools system
running Pro Tool

e A Digidesign-qualified Pro Tools system
and a third-party software application that
supports the Digidesign TDM, RTAS, or
AudioSuite plug-in standard

e A qualified Avid Xpress, Avid Xpress DV or
Avid DNA system

For complete system requirements visit the
compatibility page of the Digidesign Web site
(www.Digidesign.com/compato).

Compatibility Information

Digidesign can only assure compatibility and
provide support for hardware and software it
has tested and approved.

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, refer to the latest compatibility informa-
tion on the Digidesign Web site
(www.digidesign.com/compato).
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Convention Action

File > Save Choose Save from the
File menu

Control+N Hold down the Control
key and press the N key

Control-click Hold down the Control

key and click the mouse
button

Right-click (Windows) Click with the right

mouse button

The following symbols are used to highlight im-
portant information:

Q User Tips are helpful hints for getting the
" most from your Pro Tools system.

A\ Important Notices include information that
could affect your Pro Tools session data or
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or
mouse shortcuts.

Cross References point to related sections in
the Pro Tools Guides.



About www.digidesign.com

The Digidesign Web site (www.digidesign.com)
is your best online source for information to
help you get the most out of your Pro Tools sys-
tem. The following are just a few of the services
and features available.

Registration Register your purchase online. See
the registration form included with your system
for instructions.

Support Contact Digidesign Technical Support
or Customer Service; download software up-
dates and the latest online manuals; browse the
Compatibility documents for system require-
ments; search the online Answerbase or join the
worldwide Pro Tools community on the Digi-
design User Conference.

Training and Education Study on your own using
courses available online or find out how you can
learn in a classroom setting at a certified

Pro Tools training center.

Products and Developers Learn about Digidesign
products; download demo software or learn
about our Development Partners and their plug-
ins, applications, and hardware.

News and Events Get the latest news from Digi-
design or sign up for a Pro Tools demo.

To learn more about these and other resources
available from Digidesign, visit our Web site
(www.digidesign.com).

Chapter 1: Introduction
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Installation

Installing Plug-Ins

The Digidesign DigiRack plug-ins are installed
when you install Pro Tools. For more informa-
tion about installing Pro Tools, see the Getting
Started Guide that came with your system.

If installing multiple packages of plug-ins, do so
in the following order:

1 DigiRack plug-ins (installed with Pro Tools).

2 Packs and other bundles included with your
Digidesign system.

3 Any additional plug-ins. Check with the man-
ufacturer of your plug-ins for compatibility in-
formation and support.
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Working with Real-Time Plug-Ins

Real-time plug-ins process audio nondestruc-
tively in real time. They do not alter the original
source audio, but only apply their effect during
playback.

There are two formats of real-time plug-ins:

TDM Plug-Ins Rely on the processing power of
Digidesign DSP cards. TDM plug-ins run only on
Pro Tools|HD systems.

RTAS Plug-Ins Rely on the processing power of
your computer. RTAS plug-ins run on
Pro Tools|HD and LE systems.

You can add more mixing and processing power
to your system by installing additional DSP
cards, provided you have unused PCI expansion
slots in your computer or use a Digidesign-ap-
proved Expansion Chassis.

The System Usage window (Window > System
Usage) shows how much DSP is available on
your system, and gives an approximation of
how it is currently being used.

For more information on the System Usage
window, see the Pro Tools Reference Guide.

Processing Power
Requirements of TDM and
RTAS Plug-Ins

TDM and RTAS plug-ins differ in their process-
ing power requirements.

TDM Plug-Ins

Each real-time TDM plug-in that is inserted in a
Pro Tools session uses a portion of your system’s
total available DSP resources.

Since these DSP resources reside on the cards
that make up your particular Pro Tools hard-
ware configuration, the amount of DSP avail-
able depends entirely on the number and type
of DSP cards in your system.
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System Usage window

. See Appendix A, “DSP Requirements for
TDM Plug-Ins” for relative numbers of in-
stances of each DigiRack TDM plug-in that
can be powered by a single DSP chip. DSP
capacity differs with card type.
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DSP Sharing Between TDM Plug-Ins

With Digidesign’s MultiShell II technology, dif-
ferent types of TDM plug-ins can share the same
DSP chip at the same time. This lets you simul-
taneously use a greater variety of plug-ins by ef-
ficiently managing the DSP available on each
chip in your system.

To take advantage of this capability, plug-ins
must be MultiShell I compatible. All

DigiRack TDM plug-ins with the exception of
Direct Connect and Pitch are MultiShell II com-
patible.

Some third-party plug-ins may not be Multi-
Shell II compatible. To check compatibility,
contact the developer.

RTAS Plug-Ins

RTAS plug-ins rely on and are limited by the pro-
cessing power of your computer’s CPU. The
more RTAS plug-ins you use concurrently in a
session, the greater the impact it will have on
other aspects of your system’s performance,
such as maximum track count, the density of
edits possible, and latency in automation and
recording.

The CPU meter in the System Usage window
(Window > System Usage) shows how much of
your computer’s processing power is currently
being used by Pro Tools, and how much is still
available.

For more information on the System Usage
window, see the Pro Tools Reference Guide.
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Improving RTAS Plug-in
Performance

You can increase the number of RTAS plug-ins
your system can use concurrently by increasing
the Hardware Buffer Size and CPU Usage Limit.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the hardware cache used to han-
dle host processing tasks such as monitoring la-
tency and using Real-Time AudioSuite (RTAS)
plug-ins.

o Lower Hardware Buffer Size settings reduce
monitoring latency, and are useful when you are
recording live input.

0 Higher Hardware Buffer Size settings allow
more audio processing and effects, and are use-
ful when you are mixing and using more RTAS
plug-ins.

A In addition to causing slower screen re-
sponse and monitoring latency, higher
Hardware Buffer Size settings can affect the
accuracy of plug-in automation, mute data,
and timing for Instrument or MIDI tracks.

To change the Hardware Buffer Size:
1 Choose Setup > Playback Engine.

2 From the H/W Buffer Size pop-up menu, select
the audio buffer size, in samples.

3 Click OK.



CPU Usage Limit

The CPU Usage Limit controls the percentage of
CPU resources allocated to Pro Tools host pro-
cessing tasks such as RTAS plug-in performance
and screen redraws.

o Lower CPU Usage Limit settings limit the ef-
fect of Pro Tools processing on other CPU-inten-
sive tasks, such as screen redraws, and are useful
when you are experiencing slow system re-
sponse, or when running other applications at
the same time as Pro Tools.

o Higher CPU Usage Limit settings allocate
more processing power to Pro Tools, and are
useful for playing back large sessions or using
more real-time plug-ins.

A\ Increasing the CPU Usage Limit may slow
down screen response on slower computers.

To change the CPU Usage Limit:
1 Choose Setup > Playback Engine.

2 From the CPU Usage Limit pop-up menu, se-
lect the percentage of CPU processing you want
to allocate to Pro Tools. (On dual-processor Mac-
intosh computers, this setting controls the allo-
cation of a single processor.)

3 Click OK.

For more information on the Hardware
Buffer Size and CPU Usage Limit, refer to
the Pro Tools Reference Guide.

RTAS Plug-Ins on Auxiliary Inputs or
Master Faders

With Pro Tools HD, RTAS plug-ins can be in-
serted on Auxiliary Input and Master Fader
tracks, or after TDM plug-ins on any kind of
track.

This can affect voice usage and total latency,
and limitations on inserting or removing plug-
ins during playback. For more information, see
“RTAS Plug-Ins on Auxiliary Input and Master
Fader Tracks” on page 29.

Delay in Signal Processing

DSP and host-based processing in digital audio
systems incurs signal delay of varying amounts.
Such delays can vary from as short as few sam-
ples to as long as several hundred samples, de-
pending on the type of processing applied.

If you have recorded an instrument on multiple
tracks using multiple microphones (a drum kit
for example) and process the different tracks
with different plug-ins, the tracks may go out of
phase. You will then need to compensate for
these delays to avoid phase cancellation prob-
lems.

See Appendix B, “DSP Delays Incurred by
TDM Plug-Ins” for information on delays
inherent in specific DigiRack TDM plug-
ins. See the Pro Tools Reference Guide for a
guide to calculating DSP-induced delays.

Compensating for Delay
Use the following methods, as available, to com-
pensate for processing delay.

Delay Compensation

Use Delay Compensation to automatically cal-
culate and compensate for processing delay. For
more information on Delay Compensation, see
the Pro Tools Reference Guide.

Q Delay Compensation is automatically en-
abled on Pro Tools LE systems and cannot
be turned off.
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TimeAdjuster

You can compensate for TDM or RTAS plug-in-
induced delays by using the TimeAdjuster plug-
in. This plug-in lets you apply a specific number
of samples of delay to the signal path of a

Pro Tools track. TimeAdjuster provides settings
files that apply the correct compensation time
in samples for delay introduced by one or more
plug-ins. See “TimeAdjuster” on page 73 for
more information about the TimeAdjuster plug-
in.

For information about TimeAdjuster in
Delay Compensation sessions, see the
Pro Tools Reference Guide.

Manual Delay Compensation

You can manually compensate for processing
delay by first calculating the amount of delay on
each track, and then nudging other track’s play-
lists later or earlier in time. This method is useful
when Delay Compensation is unavailable, or
when you want to conserve resources.

Q You can also compensate for offsets in-
" curred by processing delays by using the
same plug-ins on all tracks.

Low-Latency Recording with
Instrument Plug-Ins

When an Instrument track containing an in-
strument plug-in (or a MIDI track routing MIDI
data to an instrument plug-in) is record enabled,
Pro Tools automatically suspends delay com-
pensation through the main outputs of the au-
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dio track, Instrument track, or Auxiliary Input
on which the instrument plug-in is inserted. This
allows for latency-free monitoring of the instru-
ment plug-in during recording.

A Delay Compensation for instrument plug-
ins works only when all MIDI and audio
connections take place inside of Pro Tools.
For example, Pro Tools does not suspend
delay compensation when you are using Re-
Wire to connect software synthesizers and
samplers.

MIDI and Audio Processing Plug-Ins

Some plug-ins, such as Bruno and Reso, process
audio while allowing MIDI data to control pro-
cessing parameters. When you record enable an
Instrument or MIDI track that is controlling an
Audio processing plug-in, the track the plug-in

is inserted on will go into low-latency mode, ef-
fectively making the processed audio play early.

To keep audio time-aligned when using a MIDI
controlled plug-in on an audio track:

= Start-Control-click (Windows) or Command-

Control-click (Macintosh) the Track Compensa-
tion indicator for the audio track to apply delay

compensation.

To keep audio time-aligned when using a MIDI
controlled plug-in on an Auxiliary Input:

1 Start-Control-click (Windows) or Command-
Control-click (Macintosh) the Track Compensa-
tion indicator for the Auxiliary Input to bypass
delay compensation.

2 Enter the total system delay into the User Off-
set field.



Plug-Ins as Inserts

Real-time plug-ins are available as in-line inserts
on audio tracks, Auxiliary Inputs, and Master
Faders. A maximum of 5 real-time plug-ins can
be used per track.

When more than one insert is used on a track,
they process the audio in series, each effect be-
ing added to the previous one, from top to bot-
tom in the Mix window.

Inserts can be used in two ways:

On Single Tracks An insert can be applied to an
individual audio track or Auxiliary Input using
the Insert selector on that track.

With in-line inserts, you control the level of ef-
fect by adjusting the controls of the plug-in.

As Shared Resources An insert can be used as a
shared resource in a send-and-return arrange-
ment by bussing signals from several tracks to
an Auxiliary Input, and applying the insert to
the Auxiliary Input track. With such an arrange-
ment, you can control the send level for each
track and the overall level of the effect can be
controlled from the Auxiliary Input track.

Shared arrangements let you make more effi-
cient use of your system’s processing power.

Pre-Fader Operation

Real-time plug-ins function as pre-fader inserts
(except on Master Fader tracks, where inserts are
post-fader), meaning that their input levels are
not affected by a track’s volume fader.

Real-time plug-ins are pre-fader, but post-disk.
This means that if you record to disk with a
plug-in inserted on the record track, you will
hear the effect of the plug-in, but the effect will
not be recorded to disk.

To record with a plug-in effect, create an Auxil-
iary Input, insert the desired effect on the Aux-
iliary Input track, then route the Auxiliary Input
to the audio track to which you want to record.
Alternatively, bounce the audio track with the
plug-in after recording in order to write the ef-
fected audio to disk.

Mono, Multi-Mono, and
Multichannel Plug-Ins

Plug-ins can be used in mono, multi-mono, or

multichannel formats, depending on the type of
plug-in and whether the destination is a mono
or multichannel track.

In general, when working with stereo and
greater-than-stereo tracks, use multichannel
plug-ins. If a multichannel version of a plug-in
is not available, use a multi-mono version.

v noinsert

multi-channel TOM plug-in
multi-channel RTAS plug-in

>
>
multi=-mono TOM plug=in »
multi-mono RTAS plug-in »

>

ifo
S —

Plug-in formats

Mono Plug-Ins Used on mono tracks. Some
mono plug-ins (such as Mod Delay) can gener-
ate stereo or greater-than-stereo output from a
mono channel. Plug-ins that occur on a track af-
ter a stereo plug-in are used in stereo as well.

Multi-Mono Plug-Ins Used on stereo or greater-
than-stereo multichannel tracks when a multi-
channel version of the plug-in is not available.
Multi-mono plug-ins can analyze and process
each channel independently without regard to
each other. Controls for all channels are linked
by default so that you can adjust them in tan-

Chapter 3: Working with Real-Time Plug-Ins
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dem. You can unlink controls for independent
adjustment using the Master Link button. See
“Linking and Unlinking Controls on Multi-
Mono Plug-ins” on page 19.

A\ Multi-mono plug-ins, such as dynamics-
based or reverb plug-ins, may not function
as you expect. Use the multichannel version
of a multi-mono plug-in when available.

Multichannel Plug-Ins Used on stereo and
greater-than-stereo multichannel tracks. On
greater-than-stereo multichannel tracks, the
controls for all channels are always linked to-
gether.

Organizing Plug-ins

You can customize how plug-in lists (plug-in
menus) are organized in the Insert selector and
Plug-In selector.

v noinsert

multi-channel plug-in
mulki-mona plug-in » Dynamics
Rewerb

bombFartary
Compressor (sterec)

>
>
3
ifo | Delay b Limiter (steren)

H E Modulation 3 Expander-Gate (stereo)

H E Harrnaonic ¥ Gate (stereo)

el El Dither 3

E g Instrument ¥

E g Qther L3

Plug-ins organized by categories

‘Mastararioe starea)

Fursk Lo
Shoet Dl T [sherea)

Plug-ins organized by manufacturer
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Use the “Organize Plug-In Menus By” pop-up
menu in the Pro Tools Display Preferences page
to organize plug-in menus in a Flat List (with
plug-ins in alphabetical order), Category, Manu-
facturer, or Category and Manufacturer.

“Organize Plug-In Menus By” Option

Flat List Organizes plug-ins in a single list, in al-
phabetical order.

Category Organizes plug-ins by process category
(such as EQ, Dynamics, Effects, and Delay), with
individual plug-ins listed in the category sub-
menus. Plug-Ins that do not have a Category de-
fined will appear in the Other Category folder.
Plug-ins can appear in more than one category.

Plug-In categories include:
e EQ
e Dynamics
e Pitch Shift
e Reverb
e Delay
e Modulation
e Harmonic
¢ Noise Reduction
e Dither
e Sound Field
e Hardware
e Instrument
e Other
e Wrapped Plug-Ins
o Effects

Manufacturer Organizes plug-ins by their manu-
facturer (such as Digidesign, Eventide, Line 6,
McDSP), with individual plug-ins listed in the
manufacturer submenus. Plug-Ins that do not
have a Manufacturer defined will appear in the
“Other” manufacturer folder.



Most Digidesign Development Partner plug-ins
will be sorted as Digidesign when view by man-
ufacturer is enabled.

Category and Manufacturer Organizes plug-ins
in two levels of menus. The top menus display
plug-ins by process category (such as EQ, Dy-
namics, and Delay), with individual plug-ins
listed in the category submenus. The bottom
menus display plug-ins by their manufacturer
(such as Digidesign, Eventide, Line 6, McDSP),
with individual plug-ins listed in the manufac-
turer submenus.

To select how plug-ins are organized:

1 Open or create a session.

2 Choose Setup > Preferences, and click the Dis-
play tab.

3 Click the “Organize Plug-In Menus By” pop-

up menu, and select one of the view options.

EditvWindow Default Length 0:00.000

Zoom Toggle Track Height:

Flat List

Organize Plug-In Menus By,

Cading
Category And Manufacturer

Choosing Category view for plug-in menus
4 Click Done.
The current Organize Plug-In Menus By setting

is saved with Pro Tools preferences (it is not
saved with the Pro Tools session file).

Plug-In Favorites

To find a plug-in faster, a plug-in can be desig-
nated as a favorite. Favorite plug-ins are shown
at the top of the plug-in menu.

When a plug-in becomes a favorite, it is still
shown in plug-in category and/or manufacturer
sub-menus (if enabled) and its name appears in
bold.

meini t——]
B nnml TOM plug-in o DrawmeGCLs (wwmal __ | i i
multi-channel RTAS plug-in S¢5-Fl dsterso) Favorite plug-ins
muilti-mong TDM pug-in 0 »
multi-mone KTAS plug-in » Dynamicy 3
Pech Shify »
Reverd »
Dilay 3
Medularion 13 . .
Harmanic > Plug-in categories
Hoive Reduction »
Daher »
Sound Feld »
Instruemens L3
Other L=

Menu display of favorite plug-Ins (Category view shown)

To designate a plug-in as a favorite:

= Control-click (Windows) or Command-click
(Macintosh) on a plug-in Insert button, and se-
lect a plug-in from the menu (or sub-menus, if
enabled) to designate it as a favorite.

To change the status of a plug-in favorite:

1 Control-click (Windows) or Command-click
(macintosh) on a plug-in Insert button, a nd se-
lect a plug-in favorite that you no longer want
to designate as a favorite.

2 When selecting the plug-in favorite to change,
you can select the plug-in from the list of favor-
ites at the top of the plug-in menu, or in its plug-
in category/manufacturer sub-menu (where the
plug-in appears in bold).

Inserting Plug-Ins on Tracks

To use a real-time plug-in in a Pro Tools session,
insert it on a track. Before doing so, make sure
the Inserts View is shown in the Mix or Edit win-
dow.

To show inserts in the Mix window:

= Choose View > Mix Window > Inserts.

Chapter 3: Working with Real-Time Plug-Ins
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To show inserts in the Edit window:

= Choose View > Edit Window > Inserts.

To insert a plug-in on a track:

» Click the Insert selector on the track and se-
lect the plug-in that you want to use.

- chuan ned TOM plug-in
mti-channel BTAS plug-in yramic o DrawmmrGiCLy v
Pitch Shift DrawmerECLy (st
wni-mona TOM plg-in Reverty Compressar (suereol
msi-mone RTAS plug-in Desay Liuter (stares)
Modulitian Expander-Cate (ool
Harmanic Gase txierent
Noise Reduction # 03 CompressorLimiter (enes)
3 Compressar/Limiar (stansal
Impact e real
maxim isteren)

no insert

Click {mona}

D-Verb (mona)
D-Verb {(mono/sterea)
Dither (mono)

POWr Dither (mono)
Compressor (mona)
Limiter {(mono}
Expander-Gate (mono)
Gate {maono)

DeEsser (mono)
1-Band EQ Il {mono)

RTAS plug-in [ ==

ijo [ 3 {

ErEEr

4-Band EQ Il (mono)

short delay Il {(mono)

short delay Il {mono/stereo)
slap delay Il {mono)

slan dalav Il tmann istarant

Inserting a plug-in (standard view)

Removing an Insert from a Track

To remove an insert from a track:

= Click the Insert selector and select No Insert.

TDOM plug-in
RTAS plug-in

ifo

Removing a plug-in
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Configuring Plug-Ins During
Playback

Playback must be stopped before performing
any of the following operations:

0 Inserting or removing a plug-in while record-
ing
o Dragging a plug-in to a different location

0 Inserting or removing a plug-in that changes a
track's format

0 Removing a plug-in that contains automation
data

o Enabling plug-in controls for automation
0 Creating an external key side-chain input

0 Inserting an RTAS plug-in on or removing an
RTAS plug-in from an Auxiliary Input or Master
Fader track

0 Inserting an RTAS plug-in after a TDM plug-in
on an audio track

0 Removing an RTAS plug-in from an audio
track if it comes after a TDM plug-in

0 Inserting TDM plug-ins before an RTAS plug-
in on an audio track

o Removing a TDM plug-in from an audio track
if it comes before an RTAS plug-in

Moving and Duplicating Inserts

You can move or duplicate an insert by dragging
it to a different position on the same track or a
different track. Inserts that are moved or dupli-
cated retain their original settings and automa-
tion.



To move an insert:

= Drag the insert to a new insert location.

F.
[ [E

Moving a plug-in

¥ Dragging an insert on top of an existing in-
sert will replace it.

To duplicate an insert:

= Alt-drag (Windows) or Option-drag (Macin-
tosh) the insert to a new insert location. The du-
plicated plug-in retains its original settings and
automation.

Making Plug-Ins Inactive

You can set plug-ins as inactive in order to free
up DSP resources for other plug-ins and process-
ing. When a plug-in is inactive it retains its as-
signment, position, and related automation
playlists. However, it will not pass audio and
does not consume any DSP or TDM resources.

To toggle a plug-in active or inactive:

« Control-Start-click (Windows) or Command-
Control-click (Macintosh) the Insert button.

Make the track inactive.

For more information about making tracks
inactive, refer to the Pro Tools Reference
Guide.

To toggle plug-ins in the same insert position on all
tracks active or inactive:

= Control-Start-Alt click (Windows) or Com-
mand-Control-Option click (Macintosh) an In-
sert button in the position you want to toggle.

To toggle plug-ins in the same insert position on all
selected tracks active or inactive:

» Control-Start-Alt-Shift-click (Windows) or
Command-Control-Option-Shift-click (Macin-
tosh) an Insert button in the position you want
to toggle.

Clip Indicators

Many plug-ins provide meters that let you see
when the processed signal is clipping.

In addition to clipping displays that are a part of
a plug-in’s individual interface, some plug-ins
also report the clipping in the plug-in header.
The insert button in the Mix and Edit window
also turns red if a plug-in has clipped.

[2 Thunder andBain [o]  O-vers | bypass ] o Clip
[ ctactory dotuitts -+ [@] conpars | [aita [ sate] \ED LED

Plug-In Clipping indicator in the plug-In header

LR
+[1-band £0 1

clipped

E
E

Plug-In Clipping indication in the Mix window

To clear plug-in clipping:
= Click the clip LED in the plug-in header
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To clear a clip indicator:

= Click the clip LED in the plug-in header

You can also clear plug-in, send, and, and track
window clip indicators simultaneously.

To clear all clip indicators, do one of the following:

= Alt-click (Windows) or Option-click (Macin-
tosh) any meter.

= Press Alt-C (Windows) or Option-C (Macin-
tosh).

= Choose Track > Clear All Clip Indicators.

The Plug-In Window

The Plug-In window appears whenever you click
a plug-in Insert button on a track. This floating
window lets you set the controls of any real-
time plug-in insert in use on a track.

Insert button

Insert
selector

{Ema ]

Insert button and selector on track

Settings menu Plug-In selector Compare

Track selector Previous Setting Automation Safe  Convert

plug-in
Librarian menu Next Setting Auto button
Insert Position Settings Effect | Target
selector Select Bypass| button

<factory default>

[~ [+ [ oompars. ©

Plug-In window (mono Trim shown)

Track Selector Accesses any non-MIDI trackin a
session.
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Insert Position Selector Accesses any insert on
the current track.

Plug-In Selector Lets you select any real-time
plug-in installed in the Plug-Ins folder (that is
created when you install Pro Tools).

Effect Bypass Button Disables the currently dis-
played plug-in. This lets you compare the track
with and without the effect.

Convert Plug-In Selector Lets you convert the in-
sert from a TDM plug-in to an RTAS plug-in of
the same type (or vice-versa). This feature can
only be used on plug-ins that are available in
both TDM and RTAS formats.

Clip LED Lights red to indicate if any meter in a
plug-in has clipped (not available on all plug-
ins). The Plug-In Clip LED follows Pro Tools set-
tings for clip indication (see the Pro Tools Refer-
ence Guide for more information).

Settings Menu Lets you copy, paste, save, and
import plug-in settings.

Librarian Menu Recalls settings files saved in the
plug-in’s root settings folder or in the current
session’s Settings folder. See “Using the Librar-
ian” on page 24.

Next (+) and Previous (-) Setting Buttons Let
you select the next or previous plug-in setting
from the Librarian menu.

A\ You will lose the current settings if they are
not saved before you use the Next and Pre-
vious Setting buttons. Always save your set-
tings to the Librarian menu.

Plug-Ins Settings Select Button Accesses the
Plug-In Settings dialog, which lists the settings
files for the current plug-in. From this list, you
can select a new setting, or audition a series of
settings.



Compare Toggles between the original saved
plug-in setting and any changes you have made
to it so you can compare them.

Auto Lets you enable individual plug-in controls
for automation recording. See “Automating
Plug-Ins” on page 22.

Safe When enabled, prevents existing plug-in
automation from being overwritten.

Target Button When multiple Plug-In windows

are open, clicking this button selects that plug-
in as the target for any computer keyboard com-
mands.

Key Input Selector Lets you select audio on a
particular input or bus and route it to trigger the
plug-in. This menu only appears on plug-ins
that feature side-chain processing. Key inputs
are monophonic.

MIDI Node Display Shows MIDI node informa-
tion for MIDI-enabled plug-ins. MIDI nodes are
virtual connections from Pro Tools to software
instruments and other MIDI-enabled plug-ins.
MIDI nodes are useful for routing multiple MIDI
tracks to different channels of a single virtual
MIDI device. MIDI node numbers are also dis-
played in the plug-in header and in a track’s
MIDI Output selector.

5]

Synth1 [=] Eruna [ bypass

BE sompare ||[ auto | safe

3] cractory defauits

no key input

MIDI Node

Midi Node display in a plug-in header (Bruno shown)

Master Link Button When enabled, links the
controls on all channels of a multi-mono plug-
in so that they can be adjusted in tandem.

Master Link button
Link Enable buttons
Channel selector

Audio 3 3 1-Band £Q 11 bypass

2] <factory default> - [+ [@] compare | [suto [ safe

Phase

weuT R weE Invert
TieE E a3

o WEERE 00 U
I e

| DIGIRACK | 0l

Plug-In window (multi-mono 1-Band EQ shown)

Link Enable Buttons Let you selectively link or
unlink the controls of specific channels of a
multi-mono plug-in. Each square represents a
speaker channel. The Master Link button must
be disabled to use the Link Enable buttons. See
“Linking and Unlinking Controls on Multi-
Mono Plug-ins” on page 19.

Channel Selector Accesses a specific channel
within a multichannel track for plug-in control
editing. This menu appears only on multi-mono
plug-ins inserted on tracks with more than one
channel. Shift-clicking this selector opens a sep-
arate Plug-In window for each channel of the
multichannel track on which the plug-in is in-
serted.

Phase Invert Button Inverts the phase polarity of
the input signal on some plug-ins.

Phase Invert buttons

[

B e R B R DL

I T Y T T -
[f]__tmymimit_-[+]a] =wes [ab] ] AL)

CqrpeCiipe ||

LFE Enable

Plug-In window (multichannel Compressor shown)
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LFE Enable Enables plug-in processing of the
LFE (low frequency effects) channel on a multi-
channel track formatted for 5.1, 6.1, or 7.1 sur-
round formats on some plug-ins. To disable LFE
processing, deselect this button. For more infor-
mation on the LFE channel, refer to the Pro Tools
Reference Guide.

Tempo Sync Enables compatible plug-ins to au-
tomatically synchronize to the session tempo,
for thythmic delay, echo, and similar effects. See
“Tempo Sync” on page 21 for more informa-
tion.

Opening Plug-In Windows

To open a Plug-In window:

=« Click the plug-in button in the Mix or Edit
window channel strip.

By default, each plug-in you open will appear in
the same location as a currently open plug-in,
replacing it in the same window location.

Opening Multiple Plug-In Windows

Pro Tools normally displays a single Plug-In
window from which you can adjust the controls
of any plug-in in a session. You can also open
additional Plug-In windows for specific plug-
ins.

Once you begin working with multiple Plug-In
windows, you will need to click the Target but-
ton on the plug-in whose controls you want to
adjust using keyboard commands.

To open an additional Plug-In window:

» Shift-click the Insert button for the additional
plug-in.
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To open Plug-In windows for each channel of a
multi-mono plug-in:

» Alt-click (Windows) or Option-click (Macin-
tosh) the Channel selector in the Plug-In win-
dow of the multi-mono plug-in.

To close all currently open Plug-In windows:

« Alt-click (Windows) or Option-click (Macin-
tosh) the close box of any currently open Plug-
In window.

Plug-In Window Controls

All plug-ins provide standard Pro Tools controls
for track and insert selection, bypass, and other
controls, in addition to plug-in-specific con-
trols.

To select a different plug-in on the same track:

= Click the Insert selector and select a plug-in
from the pop-up menu (or Category sub-menu).

no insert

0
et v
2] actory defai

D-Verb (stereo)
Dither (sterea)
POWr Dither (sterea)
Compressor (stereo}
Limiter (stereo)
Expander-Gate (stereo)
Cate (sterea)

v/ 1-Band EQ Il (stereo)
4-Band EQ Il (stereo)

TrPE

rreo KIS n— short delay Il (stereo)

5 = 0y slap delay Il (stereo)
medium delay Il (sterea)
long delay Il (sterea)

| DIGIRACK | FUI | exira tong delay 1 (stereo)

TimeAdjuster short (sterea)
TimeAdjuster medium (stereo)
TimeAdjuster long (stereo)

Choosing a plug-in from the Plug-In window

To choose a different track:

» Click the Track selector and choose a track
from the pop-up menu.

+ Audio 9
Audio 4
2 Thunder and Rain
Audio 2
Audio 3

+ T compare| O

v@EE

Choosing a track from the Plug-In window




Bypassing Plug-Ins

To bypass a plug-in:

= Click the Plug-In window’s Bypass button.
_or-

« Control-click (Windows) or Command-click

(Macintosh) the plug-in’s Insert button in the
Mix or Edit window.

Y

<

When a plug-in insert is bypassed, the In-
sert selector in the Mix window changes its
color to blue for easy visual reference. If
some, but not all channels of an unlinked
multi-mono plug-in are bypassed, the Insert
selector appears purple.

Some channels bypassed (purple)

Bypassed (blue)

-

Bypass states indicated by color

Unbypassed (gray)

Linking and Unlinking Controls on
Multi-Mono Plug-ins

When a multi-mono plug-in is used on a multi-
channel track, the controls are normally linked.
Adjusting the Gain control on one channel, for
example, will adjust it for all channels.

If necessary, you can unlink plug-in controls on
specific channels of a track and edit them inde-
pendently. You can also selectively link the con-
trols of specific channels.

Master Link button
Link Enable buttons
Channel selector

a 1-Band EQ 11

L
bypass r

I r
[ <hootory derout [~ [+]@] cermare mEi| ©

Channel selector and Link controls

To unlink controls on a multi-mono plug-in:

» Deselect the Master Link button.

To access controls for a specific channel:

= Select the channel from the Channel selector.

To link the controls of specific channels:

1 Deselect the Master Link button if it is not al-
ready deselected.

2 Click the Link Enable buttons for the chan-
nels whose controls you want to link.

Adjusting Plug-In Parameters

You can adjust plug-in controls by dragging the
control’s slider or knob, or by typing a value into
the control’s text box. Additonally, some plug-
ins have switches that can be enabled by click-
ing on them.

To adjust a plug-in control:

1 Begin audio playback so that you can hear the
control changes in real time.

2 Adjust the controls of the plug-in for the effect
you want. Refer to “Editing Parameters Using a
Mouse” on page 19 and “Editing Parameters Us-
ing a Computer Keyboard” on page 20.

3 Closing the plug-in will save the most recent
changes.

Editing Parameters Using a Mouse

You can adjust rotary controls by dragging hori-
zontally or vertically. Parameter values increase
as you drag upward or to the right, and decrease
as you drag downward or to the left.

Chapter 3: Working with Real-Time Plug-Ins
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Keyboard Shortcuts

o For finer adjustments, Control-drag (Win-
dows) or Command-drag (Macintosh) the con-
trol.

0 To return a control to its default value, Alt-
click (Windows) or Option-click (Macintosh)
the control.

Editing Parameters Using a Computer
Keyboard

Some controls have text boxes that display the
current value of the parameter. You can edits
the numeric value of a parameter with your
computer keyboard.

If multiple Plug-In windows are open, Tab and
keyboard entry remain focused on the plug-in
that is the target window.

To change control values with a computer
keyboard:

1 Click on the text box corresponding to the
control that you want to adjust.

2 Change the value.

e To increase a value, press the Up Arrow on
your keyboard. To decrease a value, press
the Down Arrow on your keyboard.

— Or —

e Type the desired value.

Q In fields that support values in kilohertz,
typing “k” after a number value will multi-
ply the value by 1,000. For example, type
“8k” to enter a value of 8,000.
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3 Do one of the following:

e Press Enter on the numeric keyboard to in-
put the value and remain in keyboard edit-
ing mode.

—or-

e Press Enter on the alpha keyboard (Win-
dows) or Return (Macintosh) to enter the
value and leave keyboard editing mode.

Q To move forward through the different con-
trol fields, press the Tab key. To move back-
ward, press Shift+Tab.

Enabling Switches

To enable a switch, click on the switch.

Using the Side-Chain Input

The side-chain input is the split-off signal used
by a plug-in's detector to trigger dynamics pro-
cessing, and is generally drawn internally from
the input signal. However, some plug-ins let you
switch between internal and external side-chain
processing.

With external side-chain processing, a plug-in's
detector is triggered by an external signal (such
as a separate reference track or audio source)
known as the key input.

A typical use for external side-chain processing
is to control the dynamics of one audio signal
using the dynamics of another signal (the key
input). For example, a kick drum track could be
used to trigger gating of a bass track to tighten it
up, or a rhythm guitar track could be used to
gate a keyboard pad.



Side-Chain Filters

Some plug-ins feature key high-pass and low-
pass filters. These controls let you define a spe-
cific frequency range in the side-chain signal
with which to trigger the plug-in effect. A com-
mon production technique is to use these con-
trols to filter a drum track so that only specific
high frequency sounds (such as a hi-hat) or low
frequency ones (such as a tom or a kick) trigger
the effect.

Using a Key Input for External Side-
Chain Processing

To use a key input for external side-chain
processing:

1 Click the plug-in’s Key Input selector and se-
lect the input or bus carrying the audio you
want to use to trigger the plug-in.

v = Bus 1 (Mono)

> Bus 2 (Mono}
> Bus 3 (Mono)
> Bus 4 (Mono}
> Bus 5 (Mono}
> Bus 6 (Mono)
> Bus 7 (Mono}
> Bus 8 (Mono}
> Bus 5 (Mono)
> Bus 10 (Mono)
> Bus 11 (Mana)
o . > Bus 12 (Mono}
aEn > Bus 13 (Mono)

iz "0 > Bus 14 Mono)

Selecting a key input

no key input

interface

20 E
Reduction e ——

2 Click External Key to activate external side-
chain processing.

3 Press the Spacebar to begin playback. The
plug-in uses the input or bus that you chose as a
key input to trigger its effect.

4 During playback, do any of the following to
fine-tune side-chain triggering:

e To hear the audio source you have selected
to control the side-chain, enable Side-
Chain Listen or Key Listen (depending on
the plug-in). When finished, disable Side-
Chain Listen/Key Listen to resume normal
plug-in monitoring.

e To filter the side-chain so that only specific
frequencies trigger the plug-in, use the fil-
tering controls (if available) to select the
desired frequency range.

5 Adjust the plug-in’s Threshold control (if
available) and other controls as needed.

Tempo Sync

Pro Tools provides Tempo Sync to enhance MIDI
Beat Clock support and overall tempo capabili-
ties of plug-ins (such as ReWire client applica-
tions) that utilize MIDI Beat Clock.

Tempo Sync provides a direct connection be-
tween session tempo and plug-in parameters
that support MIDI Beat Clock. This direct con-
nection lets plug-in parameters such as delay,
auto-pan, and other time-domain effects auto-
matically synchronize to and follow changes in
session tempo.

Tempo Sync simplifies MIDI Beat Clock config-
uration by making session tempo available to
relevant plug-in parameters directly from
within the plug-in window. For plug-ins that do
not support Tempo Sync, the original MIDI Beat
Clock window (Setup > MIDI > MIDI Beat Clock)
remains available in Pro Tools.
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Compatibility and Settings

When opening older sessions that included
plug-ins that subscribe to MIDI Beat Clock,
Tempo Sync will be automatically enabled. Any
plug-ins that used automation for tempo
change should have that automation suspended
or deleted to avoid conflict with Tempo Sync.

A Tempo Sync is not available in plug-ins
with which it would limit functionality. For
example, for the Access Music Virus Indigo
and IndigoV40 plug-in, use the Pro Tools
MIDI Beat Clock window (Setup > MIDI >
MIDI Beat Clock). See the Pro Tools Refer-
ence Guide for more information.

To utilize Tempo Sync:

1 Insert a plug-in that supports Tempo Sync,
such as the DigiRack Mod Delay II.

2 Click the Tempo Sync icon. The tempo shown
will change to match the current session tempo.

Tempo Sync
|
reweo NN 4]
werer /R ][] [J] (][]
croove [HEEY ¥

Tempo Sync icon (Mod Delay Il shown)

3 To set a rhythmic delay, click a note value
(whole, half, quarter, eighth, or sixteenth), then
do any of the following to further adjust the
rhythm:
e To enable triplet delay timing, click the 3
button so that it is lit.
e To set a dotted delay value, click to enable
the dotted icon.
e To apply some swing to the delay value, ad-
just the Groove slider.
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Automating Plug-Ins

You can automate changes to plug-in controls.
Because Pro Tools creates a separate playlist for
each plug-in control that you automate, you can
later edit and modify each automated control
individually. This lets you to build up complex
automation in stages.

Q To create automation for a stereo plug-in
with separate controls for each channel,
(such as Mod Delay), record the automation
for one channel, then copy and paste it to
the other channel.

For complete instructions on Pro Tools au-
tomation, refer to the Pro Tools Reference
Guide.

To enable plug-in controls for automation:

1 Open the Plug-In window for the plug-in you
want to automate.

2 Click the Automation Enable button in the
Plug-In window.

Plug-In Automation

&)
2 Thunder and Rain | a | D-verb | [ thpass

<Factory default> + @] compare | [auth [ safe

Accessing the Plug-In Automation dialog

Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click the Track View se-
lector in the Edit window.

Q You can also Control-Alt-Start-Right-click
(Windows) or Command-Option-Control-
click (Macintosh) any plug-in control in the
Plug-In window, then choose Open Auto-
mation Dialog from the pop-up menu.



3 Choose the controls to automate and click
Add. If there are multiple plug-ins on the same
track, you can select from among these by click-
ing their buttons in the Inserts section of this di-
alog.

Plug-In Automation

Master Bypass Twpe
Input € Add>> Gain

Freauency
Q

Inserts

) None
M 1-pand EQ I
) None
" None
) None

Cana ) @oe)

Plug-In automation dialog

4 Click OK to close the Plug-In Automation di-
alog.

Q As an alternative to using the Plug-In Auto-
" mation dialog, you can enable individual
plug-in controls directly from the Plug-In
window by Control-Alt-Start-clicking (Win-
dows) or Command-Option-Control-click-
ing (Macintosh) the control.

weyT UER

e
- Disable Automation for "Type "

GAIN _ Open plug-in Automation Dialog....
Freq IR

Shortcut for enabling plug-in automation

TYPE

To automate a plug-in:

1 In the Automation Enable window, make sure
plug-in automation is enabled.

Plug-In Automation Enable button

Automation Enable window

2 Select an Automation mode for each track
containing plug-ins you want to automate. For
the initial automation pass, choose Auto Write.

3 Click Play to begin writing automation, and
move the controls you want to automate.

4 When you have finished, click Stop.

After the initial automation pass, you can write
additional automation to the track without
completely erasing the previous pass by choos-
ing Auto Touch mode or Auto Latch mode.
These modes add new automation only when
you actually move the control.

Record Safing Plug-In Automation

You can protect plug-in automation from being
overwritten by using Automation Safe mode.

To enable plug-in safe mode:

1 Open a plug-in.
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2 Click the Safe button so that it is highlighted.

Safe enabled

udio 3 a 1-Eand EQ | bypass

[E_<roctory derouit [~ +]@] cermars. ©

Automation Safe enabled plug-in

To disable plug-in safe mode:

« In the Plug-In window, click the Safe button
so that it is unhighlighted.

Using the Librarian

The Settings Librarian makes it easy to create
your own library of plug-in settings. Using the
Librarian and Settings pop-up menus, you can
copy, paste, save, and import these settings from
plug-in to plug-in, or from session to session.

Audio 1 1-Band EQ 1I

i Drum EQs
[ Guitar EQs | 3
[ Vocal EQs >

<factory default>

can GRS Ly
Frea KIEEE Iy
- TE—
[ DIGIRACK ol

Librarian menu

Once you create and save settings files to disk
(and tell Pro Tools where to find them by assign-
ing their root folder) they will appear in the Li-
brarian menu (and in the Plug-In Settings dia-
log).

Q You can also use the Plug-In Settings dialog
" to select settings or audition them. See
“Plug-In Settings Dialog” on page 27.
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The Settings Menu

Use the Settings menu commands to save, copy,
paste, and manage plug-in settings files.

Save SeTTINgS
Sawe Settings As...
Copy Settings OBc

1MpOrT Satings

Sat Plug-in Datault To
Save Plug-in Settings To

Set Root Settings Folder..

»
L3 ' Root Settings Fosder
Sessian Falder

DIGIRACK

Settings menu

Settings menu commands include:

Save Settings Saves the current settings. This
command overwrites any previous version of
the settings. The setting then appears in the Li-
brarian menu.

Save Settings As Saves the current settings un-
der a different name.

Copy Settings Copies the current settings. You
can then apply these settings to the same type of
plug-in on a different track by choosing the
track in the Plug-In window and pasting the set-
tings with the Paste Settings command.

Paste Settings Pastes settings copied with the
Copy Settings command.

Import Settings Imports a settings file from a lo-
cation other than the Root Settings folder or Ses-
sion folder.

Delete Current Settings File Permanently de-
letes the current settings file from disk.

Lock Settings File Prevents the current settings
from being overwritten by the Save command.
If you attempt to save control settings, you will
be required to save them using a different name
or disk location.



Set As User Default Defines the current settings
as the User Default for a specific plug-in.

Settings Preferences

The Settings Preferences sub-menus are for
choosing preferences for saving and importing
plug-in settings. They include:

Set Plug-In Default To Sets the default setting to

either Factory Default (the standard default set-
ting for that plug-in) or User Default (your cus-

tom setting you specify with the Set As User De-
fault command).

Save Plug-In Settings To Selects the folder where
plug-in settings are saved. If you choose Session
Folder, the settings are saved in a folder named
“Plug-In Settings” within the current Session
folder. If you choose Root Settings Folder, the
settings are saved in the folder you specified
with the Set Root Settings Folder command (see
below).

Set Root Settings Folder Selects a location or
root folder for saving and importing settings.
This root settings folder must be named “Plug-
In Settings.” Use this command only if you want
to choose a location other than the default Plug-
In Settings folder.

The default location for the Root Plug-In Set-
tings folder is as follows:

Windows Program Files\Common Files\
Digidesign\DAE\Plug-In Settings

Macintosh Library/Application Support/
Digidesign/Plug-In Settings

A\ To save plug-in settings to any location
other than the default Plug-In Settings
folder, you must first create a folder named
“Plug-In Settings” in the new location and
then save to that folder.

Choosing a Destination for
Settings

Before you save plug-in settings, select their des-
tination folder.

To select a destination folder:

« From the Settings pop-up menu, choose Set-
tings Preferences > Save Plug-In Settings To, and
choose Session Folder or Root Settings Folder.

If you choose Root Settings folder, Pro Tools
saves settings to the default Root Plug-In Set-
tings folder unless you have specified a different
location for the Root Settings folder.

To select a different Root Settings folder:

1 From the Settings pop-up menu, choose Set-
tings Preferences > Set Root Settings Folder.

2 Select the folder you want to use as your Root
folder and click Select.

Managing Settings

Use the Settings pop-up menu to manage set-
tings.

A\ Unlinked multi-mono plug-ins have specific
rules for settings. See “Editing Settings on
Unlinked Multi-Mono Plug-ins” on
page 27.

To save a setting:

1 Choose Save Settings from the Settings pop-
up menu.

2 Type a name and click OK. The setting appears
in the Librarian menu.

Press Control+Shift+S (Windows) or Com-
mand+Shift+S (Macintosh) to save plug-in
settings.
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To load a previously saved setting:

= Choose the setting from the Librarian pop-up
menu.

To import a setting:

1 Choose Import Settings from the Settings pop-
up menu.

2 Locate the settings file you want to import
and click Open. Pro Tools loads the setting and
copies it to the root destination folder.

To copy a setting:
= Choose Copy Settings from the Settings pop-

up menu.

Press Control+Shift+C (Windows) or Com-
mand+Shift+C (Macintosh) to copy plug-in
settings.

To paste a setting:

1 Open the source plug-in.

2 Choose Copy Settings from the Settings pop-
up menu.

3 Open the destination plug-in.

4 Choose Paste Settings from the Settings pop-
up menu.

Press Control+Shift+V (Windows) or Com-
mand+Shift+V (Macintosh) to paste plug-
in settings.

To create a custom User Default setting:

1 Create and save a setting.

2 Choose Set As User Default from the Settings
pop-up menu.
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To make a plug-in default to your custom setting:

=« From the Settings pop-up menu, choose Set-
tings Preferences > Set Plug-In Default To > User
Setting.

Creating Subfolders for Settings

To make it easier to find specific types of set-
tings, you can subdivide settings files by creat-
ing subfolders for them.

4]
[ uini [b] iBmdcan

m Drum EQs Hi Hat 1
[1 Guitar EQs » Kick
[0 Vocal EQs » Snare

ue

<factory default=

can  IENEEEE i
Frco KR I
o EEER I
Wl

Librarian menu with subfolders for settings

To create a settings subfolder:

1 From the Settings pop-up menu, choose Save
Settings.

2 Click the New Folder button and type a name
for the subfolder.

3 Name the setting and click Save. The setting is
saved within the subfolder.



Changing Settings with the
Next (+) and Previous (=) Settings
Buttons

The Next (+) and Previous (-) Settings buttons
let you select the next or previous setting of the
Librarian menu.

To change plug-in settings using the Next (+) and
Previous (-) Settings buttons:

= Press the Plus (+) or Minus (-) buttons to select
the next or previous plug-in settings file. The
next (or previous) settings file are enabled, and
the Librarian menu changes to reflect the new
setting.

Editing Settings on Unlinked Multi-
Mono Plug-ins

When a multi-mono plug-in is unlinked, im-
porting, copying, pasting, or bypassing settings
affects only the currently selected channel.

To apply an operation to all channels of an
unlinked plug-in:

= Hold down the Alt key (Windows) or Option
key (Macintosh) while performing the com-
mand.

Plug-In Settings Dialog

The Plug-In Settings dialog lists the settings files
for the current plug-in type. From this list, you
can select a new setting, or audition a series of
settings. Auditioning plug-in settings is espe-
cially useful for selecting patch names for virtual
MIDI instrument plug-ins or trying out different
effects types applied to your audio.

The Plug-In Settings dialog includes the follow-
ing:

Folder This pop-up menu lets you switch be-
tween session settings located in root or session
folders (and any available subfolders)

Patch Field This field displays the name of the
active (highlighted) setting.

Increment Patch Every X Sec This option lets
you audition contiguous plug-in settings on-
the-fly by automatically scrolling through them
for a specified number of seconds.
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Plug-In Settings dialog

To change plug-in settings using the Plug-In
Settings dialog:

1 Click the Settings Select button.

Indigo 1
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Select

no key input

Plug-in header settings

To switch between settings folders, press
Control (Windows) or Command (Macin-
tosh) and use the Up/Down Arrow Keys.
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2 From the dialog list, select the desired plug-in
setting.

— Or —

Use the Arrow keys to scroll through the avail-
able settings.

3 Click Done.

Auditioning Plug-in Settings

When the Plug-in Settings dialog is open, you
can have Pro Tools automatically scroll through
and audition the settings files saved in the plug-
in’s root settings folder or in the current ses-
sion’s Settings folder.

To audition plug-in settings:
1 Click the Settings Select button.

2 From the Settings dialog, click a setting—the
starting point from which you will scroll
through the settings files.

3 Enter a value for the number of seconds that
will elapse between each program change, and
press Enter.

4 Select the option for Increment Patch.

After the specified number of seconds, Pro Tools
selects the next setting.

5 When you are finished auditioning settings,
do one of the following:
e Click Done to stop incrementing patches,
and to close the Plug-In Settings dialog.

e Select the Increment Patch option to stop

incrementing patches and keep the Plug-In
Settings dialog open.
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Multiple Outputs for
Instrument Plug-Ins

You can route the output of an instrument plug-
in to the main track outputs and to individual
track inputs on other tracks. This lets you route
multiple samples or synth sounds through sepa-
rate outputs for individual processing.

For specific information about using multi-
ple plug-in outputs with third-party plug-
ins, consult the documentation from the
plug-in manufacturer.

Main and Auxiliary Plug-In Outputs

When a plug-in that has both main and auxil-
iary outputs is inserted on a track, the plug-in’s
main outputs are routed through the track that
the plug-in is inserted on, and the plug-in’s aux-
iliary mono or stereo outputs are available in the
track input pop-up menu on other tracks.

Q If none of the inserted plug-ins has auxiliary
outputs, the plug-in category in the track in-
put pop-up menu is grayed out.

HTDM Plug-In Conversion to
RTAS

When you use Pro Tools 7.0 or higher to open a
session that was last saved in a version of

Pro Tools prior to 7.0, most HTDM plug-ins will
be automatically converted to their RTAS coun-
terparts.

However, in rare cases as with some third-party
plug-ins, these plug-ins will not automatically
convert to RTAS and display as inactive. This
means that the plug-in either has not been con-
figured for automatic conversion or that no
RTAS version is available.



In such cases, you must manually convert each
individual HTDM plug-in to its RTAS counter-
part by selecting it’s RTAS version from the In-
sert selector or the Convert Plug-In pop-up
menu. If an RTAS version is not available, the
HTDM version will remain inactive.

A\ When HTDM plug-ins are converted to
RTAS, any RTAS plug-ins that precede
TDM plug-ins on audio tracks will be by-
passed if you enable Record Enable or
TrackInput monitoring on that track. See
“Ordering RTAS and TDM Plug-Ins on an
Audio Track” on page 30 for details.

RTAS Plug-Ins on Auxiliary
Input and Master Fader Tracks

(Pro Tools HD Only)

In Pro Tools HD, RTAS plug-ins can be inserted
on Auxiliary Input and Master Fader tracks, or
after TDM plug-ins on any kind of track.

Q While HTDM plug-ins have a fixed buffer
" size, latency caused by RTAS plug-ins is ad-
justable via the HW Buffer Size setting in
the Playback Engine dialog. For more infor-
mation, see the Pro Tools Reference Guide.

A\ When you use a previous version of
Pro Tools to open a session originally cre-
ated in Pro Tools 7.0, any RTAS plug-ins
inserted on Auxiliary Input or Master Fader
tracks—or after TDM plug-ins on any kind
of track—will become inactive.

This also affects the following RTAS-related be-
havior in Pro Tools:

e Voice usage and total latency for RTAS
plug-ins

e Limitations on inserting or removing plug-
ins during playback

Voice Usage and Total Latency for
RTAS Plug-Ins

With Pro Tools HD, the initial insert of an RTAS
plug-in may cause additional latency, and will
take up two additional voices per channel
(1 voice for input and 1 voice for output) in the
following conditions:
e When inserted on an Auxiliary Input or
Master Fader track

e When inserted on an Instrument track that
does not contain an instrument plug-in

e When inserted after a TDM plug-in on any
kind of track

For example, the initial insert of an RTAS plug-
in on a mono Auxiliary Input track uses two
voices (one channel with two voices), while the
initial insert of that plug-in on a stereo Auxiliary
Input track uses four voices (two channels with
two voices each).

Subsequent RTAS plug-ins on the same track do
not take up additional voices unless a TDM
plug-in is inserted between other RTAS plug-ins.

A Avoid inserting TDM plug-ins between
RTAS plug-ins on any kind of track—this
causes unnecessary voice usage and may
cause additional latency.

Furthermore, one additional voice is used for
each occurrence of any of the following condi-
tions when using voices for RTAS plug-ins on a
track:
e When you use an external side-chain for an
RTAS plug-in on that track
e When you select multiple outputs for that
track (one voice used for each output)

e When you select an AFL/PFL Path output
in the Output tab of the I/O Setup dialog
(one voice used for each channel)
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Ordering RTAS and TDM Plug-Ins on an
Audio Track

With Pro Tools HD, when RTAS and TDM plug-
ins are combined on an audio track, the order in
which they are inserted has different results:

RTAS Plug-Ins Grouped Before TDM Plug-Ins No
additional voices will be used, and no process-
ing latency will occur. RTAS plug-ins will be by-
passed when Record Enable or TrackInput mon-
itoring is enabled for that track.

TDM Plug-Ins Grouped Before RTAS Plug-Ins

Each initial insert of an RTAS plug-in after a
TDM plug-in will cause processing latency, and
will use voices as described in “Voice Usage and
Total Latency for RTAS Plug-Ins” on page 29.
RTAS plug-ins will stay active while Record En-
able or TrackInput monitoring is enabled for
that track.

A As arule, always group plug-ins of the same
type together, especially if inserting RTAS
after TDM plug-ins. Otherwise, additional
voices may be unnecessarily used, and un-
necessary latency may result.

Ordering Recommendations

When combining RTAS and TDM plug-ins on
an audio track, use one of the following two
strategies based on your recording needs:

e To ensure that RTAS plug-ins stay active when
you record enable a track or use TrackInput
monitoring, group all TDM plug-ins before
RTAS plug-ins.

— Or —

e To conserve voices and minimize processing
latency, group all RTAS plug-ins before TDM
plug-ins.

30 DigiRack Plug-Ins Guide

Limitations for Inserting or
Removing Plug-Ins During
Playback

When playing back tracks containing RTAS
plug-ins, the following limitations on inserting
or removing plug-ins apply:
e RTAS and TDM plug-ins cannot be inserted
on or removed from Auxiliary Input, Mas-
ter Fader, or Instrument tracks.

e An RTAS plug-in cannot be inserted after a
TDM plug-in on an audio track, or removed
from an audio track if it comes after a TDM
plug-in.

e A TDM plug-in cannot be inserted before
an RTAS plug-in on an audio track, or re-
moved from an audio track if it comes be-
fore an RTAS plug-in.



chapter 4

Working with AudioSuite Plug-Iins

AudioSuite plug-ins differ from TDM and RTAS
plug-ins in that they are used to process and
modify audio files on disk rather than non-
destructively in real time. Depending on how
you configure a non-real-time AudioSuite plug-
in, it will either alter the original source audio
file or create an entirely new audio source file.

The AudioSuite Menu

AudioSuite plug-ins are accessed through the
AudioSuite menu.

Plug-ins can be organized in the AudioSuite
menu in Pro Tools by Flat List (with plug-ins in
alphabetical order), Category, Manufacturer, or
Category and Manufacturer.

For more information, see “Organizing
Plug-Ins” on page 12.

AudioSuite Plug-ins

1-Band EQ Il Processes audio with selectable EQ
filters in a 1-band module.

2-4 Band EQ lll Processes audio with two, three,
or four selectable EQ filters.

7-Band EQ Il Processes audio with up to seven
selectable EQ filters.

Click Creates an audio click as a tempo reference
for performing and recording.

Compressor Processes audio with compression.
Chorus Processes audio with chorusing.
Flanger Processes audio with flanging.

Limiter Processes audio with limiting.

Gate Processes audio with gating.

Expander Gate Processes audio with expander-
gating.

De-esser Processes audio with de-essing to re-
move sibilance.

Duplicate Creates a new, continuous source au-
dio file (and region) from the selection.

Delay Adds up to 10.9 seconds of delay.
Multi-Tap Delay Adds up to four independently-

controllable delays to the original audio signal.
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Normalize Uniformly adjusts all levels in a re-
gion or regions to a user-definable level, using
the loudest peak in the audio file as the refer-
ence.

Ping-Pong Delay Adds a stereo, ping-pong delay
to the audio signal by feeding back the original
signal to its opposite channel.

Gain Adjusts gain (volume) change, in decibels
or percentage before clip.

Invert Inverts phase (polarity).

Pitch Shift Changes an audio file’s pitch with or
without changing its duration.

Reverse Rewrites selected audio in reverse.

DC Offset Removal Recognizes and removes DC
offset from audio files.

Signal Generator Generates audio tones for
equipment calibration purposes.

Time Compression/Expansion Changes an audio
file’s duration with or without changing its
pitch.

32 DigiRack Plug-Ins Guide

The AudioSuite Window

When you choose a plug-in from the
AudioSuite menu, the AudioSuite window ap-
pears. From this floating window you can access
and edit the controls for any non-real-time Au-
dioSuite plug-in.

Settings menu Previous Selection
Setting Reference

Librarian menu
Next

Setting

File Mode selector Stereo Processing Mode button

Plug-in Use in Playlist button
selector
Process
Mode
|
[ | "uze in playlist
ate continuous file | ntire selection steren mode

B[ tery doraato - |'+ || compre

Preview  Bypass Settings Process
button  button Select button

AudioSuite window

Plug-In Selector

From this menu you can select any AudioSuite
plug-in installed in your Plug-Ins folder. (The
Plug-In selector follows the Pro Tools preference
for Organize Plug-Ins Menu By.)

Flanger

use in playlist

Mulki-Tap Delay
Mormalize process
Ping-Pong Delay
Pitch Shift
Reverse

Signal Generator
Time Compression Expansian

Plug-In selector menu (flat list, non-category view)



Selection Reference

This menu aims the selected process at either re-
gions selected in an audio track or playlist, or at
regions selected in the Audio Regions List.

When you select a region on-screen (in either a
track/playlist or the Region List) Pro Tools nor-
mally selects both occurrences of the region.
Since you may not want to process both, this
menu provides a convenient means of limiting
the AudioSuite process to regions selected in
one or the other.

Playlist Applies AudioSuite processing only to
regions currently selected in tracks/playlists in
the Edit window. Processing will not be applied
to regions in the Audio Regions List.

create continuous file

Selection Reference pop-up menu (Invert plug-in shown)

process

Region List Applies AudioSuite processing only
to regions currently selected in the Audio Re-
gions List. Processing will not be applied to re-
gions located in tracks and playlists in the Edit
window.

A\ If the Use In Playlist option is enabled in
addition to Region List being selected in the
Selection Reference pop-up menu, the pro-
cessing will be applied to the selected region
in both the playlist and the Regions List.

Use In Playlist Button

This button determines whether the AudioSuite
plug-in will replace all instances of the selected
regions everywhere in the session, or only the
occurrences of the regions that are currently se-
lected.

use in playlist |

Use in Playlist button

Use In Playlist Off When Use in Playlist is dis-
abled, a new, processed version of the selected
region will be added to the Regions List. No orig-
inal regions will be replaced or overwritten any-
where in the session.

Use In Playlist On, Reference = Region

List When Use in Playlist is enabled and the Se-
lection Reference pop-up menu is set to Regions
List, all copies of the selected region will be re-
placed everywhere in the session.

Use In Playlist On, Reference = Playlist When
Use in Playlist is enabled and the Selection Ref-
erence menu is set to Playlist, only regions se-
lected in tracks in the Edit window will be re-
placed. If the session includes other copies of
the region used in other playlists, those copies
of the original, unprocessed region will not be
replaced.

A\ Ifthe Selection Reference pop-up menu is set
to Region List, the Use in Playlist button
will automatically be disabled to ensure
that you do not accidentally replace every
occurrence of the region in a session.
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File Mode Selector

This menu lets you select whether or not the
AudioSuite plug-in will process the selected au-
dio destructively or nondestructively, and how
the original files will be modified.

overwrite files

use in playlist

create co

create continuous

File Mode pop-up menu (Invert plug-in shown)

There are three options:

Overwrite Files Processes the selected regions de-
structively, overwriting the original audio. Not
all AudioSuite plug-ins can be used destruc-
tively.

Create Individual Files Processes the selected re-
gions nondestructively, creating a new audio
file for each region. The new audio files are
added to the session, leaving the original source
audio files in the Regions List unchanged.
(Whether the processed audio is added to the
current playlist or only to the Regions List, is de-
termined by the Selection Reference setting, as
explained earlier.)

Create Continuous File Processes the selected re-
gions nondestructively and creates a new audio
file consisting of the selected regions consoli-
dated into a single, unbroken region. This mode
is particularly useful if you are assembling a
composite track from multiple takes. This mode
is not available when the Selection Reference is
set to Region List.

Q The Create Continuous File option is not
" available with some time domain plug-ins.
To achieve a similar result, use the Dupli-
cate plug-in to consolidate regions processed
with these plug-ins.
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Process Mode Selector

If you have made a selection that includes mul-
tiple regions, this pop-up menu lets you specify
whether AudioSuite processing is performed on
a region-by-region, or entire-selection basis.

cregte continuous file

Process Mode selector (Invert plug-in shown)

Region by Region Analyzes each region in a se-
lection individually, rather than over the entire
multi-region selection as a whole.

Entire Selection Uses the entire selection for
analysis. All regions will be analyzed and pro-
cessed relative to the entire selection.

Chan/Track Process Mode Selector

If you have made a selection that includes re-
gions from multiple tracks, the Normalize
AudioSuite plug-in (as well as some third-party
AudioSuite plug-ins) lets you choose whether
you want to perform processing on a channel-
by-channel/track-by-track, or an all-chan-
nel/all-tracks basis using the Chan/Track Process
Mode selector.

Chan/Track Process Mode selector pop-up menu
(Normalize plug-in shown)



Peak On Each Chan/Track Analyzes and pro-
cesses each selected track individually. If you ap-
ply the Normalize plug-in to multiple tracks or a
multichannel track in Peak On Each Chan/Track
mode, each channel or track will be normalized
independently, without regard to the other se-
lected tracks.

Peak On All Chans/Tracks Uses all currently se-
lected channels and tracks for analysis. If you
apply the Normalize plug-in to a multichannel
track or multiple tracks in Peak On All
Chans/Tracks mode, the tracks will be analyzed
as a single entity and regions will be normalized
relative to the averaged peak level within all se-
lected channels and tracks.

Preview

The Preview button lets you audition the effect
of a plug-in before you process the audio. By ad-
justing the plug-in controls while you listen to

this audio preview, you can fine-tune the effect.
Not all AudioSuite plug-ins support this feature.

The Preview function routes audio to the spe-
cific outputs you have chosen with the Audition
pop-up menu in the Outputs page of the

1/O Setup dialog. Make sure you have config-
ured this option correctly for your system or you
may not be able to hear previewed audio.

For more information on using the I/O
Setup dialog to configure your system’s au-
dio outputs, refer to the Pro Tools Reference
Guide.

Before you use Preview, be aware that:

0 The performance of the Preview function de-
pends on the speed of your CPU. Faster comput-
ers preview AudioSuite effects better than slower
computers.

0 Regardless of how many tracks and regions
are currently selected, the Preview button will
audition only the first selected stereo track or
the first selected pair of mono tracks.

o If you are using Region-by-Region processing
mode, the Preview function will preview only
the first region within a multi-region selection.
To hear all selected regions, temporarily select
Create Continuous File from the File Mode
menu before previewing.

0 The Preview function is affected by the
AudioSuite Buffer Size option (on the Processing
page of the Pro Tools Preferences dialog). See
“AudioSuite Processing Preferences” on page 37.

Bypass

When Bypass is enabled, the selected audio is
auditioned without AudioSuite processing. The
Bypass button applies only to previewing. It
does not affect actual AudioSuite processing.

Process

Clicking this button begins AudioSuite process-
ing of the selected audio. Processing can occur
during playback (though it may take slightly
longer). Processed files are auto-named with the
region or audio file’s name plus an acronym for
the chosen AudioSuite process.

New files are written to the hard disk specified
for that track in the Disk Allocation dialog, or to
the same drive as the original file if the region is
not currently on a track. See “Auto-File Naming
of AudioSuite-Processed Audio” on page 36.
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Multichannel Processing

Most DigiRack AudioSuite plug-ins can process
up to 48 channels of audio simultaneously.

A\ When processing multiple regions of differ-
ent formats (mono and multichannel sur-
round, for example), all channels will be
processed according to the channel format
of the AudioSuite plug-in. Mono AudioSuite
plug-ins can process stereo regions and ste-
reo AudioSuite plug-ins can process mono
regions.

Undoing AudioSuite Processing

If you have processed an audio selection nonde-
structively, the Undo and Redo commands let
you undo the selected AudioSuite process. You
can undo or redo an AudioSuite process during
audio playback.

A\ Undo is not available when a plug-in is con-
figured for destructive editing since the pro-
cess has already overwritten the source au-
dio file.

Auto-File Naming of AudioSuite-
Processed Audio

When new audio files are created as a result of
AudioSuite processing, Pro Tools will auto-name
these files according to the type of plug-in used.
The name of the region determines the prefix,
while the type of AudioSuite plug-in determines
the suffix.

Auto file-naming follows these rules:

o New regions are named beginning with the
region name, followed by an abbreviation of the
current AudioSuite process, followed by stan-
dard Pro Tools file and region numbering.

o If a plug-in’s File Mode pop-up is set to Over-
write, the original region’s name will not be
changed.
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o If a plug-in’s File Mode pop-up is set to Create
Individual Files, the resulting regions will have
an abbreviated version of the plug-in name ap-
pended to them.

Other AudioSuite Controls

In addition to the standard AudioSuite controls,
there are a number of special-purpose controls
found on certain plug-ins:

Plug-In Librarian and Settings Menus

The Settings and Librarian pop-up menus that
appear in some AudioSuite plug-ins provide a
means of saving, loading, copying, pasting and
organizing custom plug-in settings files. See
“Using the Librarian” on page 24.

Analyze Button

This button analyzes a selection without actu-
ally processing it. On the DigiRack Gain plug-in,
you can use the Analyze feature to determine
the maximum peak level on a track at a specific
gain value before you process the audio.

Key Input Selector

Selects a track/bus to be used to trigger process-
ing. In order to use this feature, the key input
source audio must occur at the same time as the
target audio. Side-chain input is monophonic.
See “Using the Side-Chain Input” on page 20.

A\ Side-chain inputs for plug-ins have no effect
on AudioSuite processes when the Selection
Reference is set to Region List.



Channel Mode Button

The Channel Mode button lets you process con-
tiguous channels within a selected region as
though they were mono or stereo tracks (and in
some cases greater-than-stereo tracks), regard-
less of the type of tracks they occupy.

Mono Mode Processes each contiguous channel
within a selected region as a separate mono
track. For example, a region comprised of six
mono tracks would be processed as six mono
tracks.

Stereo Mode Processes each contiguous pair of
channels within a selected region as a stereo
track. When applied to an odd number of chan-
nels, the plug-in processes the last odd, un-
paired channel as mono, using the left channel
settings of the stereo plug-in. If you want the
last track to be processed in stereo, you must se-
lect an additional track to pair it with—an
empty one if necessary.

For example, a region comprised of two mono
tracks would be processed as a stereo track, with
the first mono track processed as the left chan-
nel and the second mono track processed as the
right channel.

Multi Mode Processes each set of three or more
contiguous channels within a selected region as
a multichannel greater-than-stereo track, with
the number of selected channels determining
the type of track. For example, five contigu-
ously-selected channels would be processed as a
5.0 track, while seven contiguously-selected
channels will be processed as a 7.1 track.

A\ Multi mode is available only for certain
plug-ins, such as Dynamics II1.

AudioSuite Processing
Preferences

Before you begin using AudioSuite plug-ins, use
the Preferences dialog (Setup > Preferences >
Processing) to configure default AudioSuite op-
tions according to your needs. These options in-
clude the default dither setting, a dither on/off
checkbox, and the AudioSuite buffer size op-
tion.
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AudioSuite Dither When selected, dither is ap-
plied during certain AudioSuite processes (such
as Normalize and Gain), using the dither algo-
rithm selected in the Dither Plug-In pop-up
menu. Dither is most useful when working with
low-level files that contain a fade in or fade out.

Dither Plug-in AudioSuite plug-ins always create
files that inherit the session’s bit depth. With
the Dither Plug-In pop-up menu you can choose
the dither algorithm used for dithering higher-
bit source files during AudioSuite processing.
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Edit Settings Accesses options for the currently
selected Default Dither plug-in. In the case of
the Digidesign Dither plug-in, this lets you to
turn noise shaping on or off.

See “Noise Shaping” on page 57 for more
information.

Bit Depth Selects the default bit depth used by
the dither function during AudioSuite process-
ing. Bit depth can be set to 16-, 18-, 20-, or 24-
bit.

For an explanation of dither, See “Dither”
on page 56.

AudioSuite Buffer Size Selects the size of

Pro Tools memory buffer for processing and pre-
viewing AudioSuite plug-ins. Choices are Mini,
Small, Medium, Large, or Jumbo. In general,
choosing a smaller buffer speeds up AudioSuite
previewing functions. Choosing a larger buffer
speeds up AudioSuite processing of audio files.
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To configure the AudioSuite Buffer Size:

1 Choose Setup > Preferences.
2 Click Processing.

3 Select an AudioSuite Buffer Size.

Though the default setting will work well for
most situations, you may want to set the buffer
according to your current task. Before you audi-
tion an AudioSuite plug-in, set this buffer to
Mini or Small. Then, when you are ready to pro-
cess a file, reset it to Large or Jumbo.

4 Click Done.

TC/E Selects the Time Compression & Expan-
sion plug-in and default settings used when ed-
iting with the Time Trimmer tool. If you own a
compatible third-party time compression and
expansion plug-in, you have the option of using
it for Pro Tools time compression and expan-
sion processes by selecting it here.

Refer to the Pro Tools Reference Guide for
more information about the Time Trimmer
tool.



Using AudioSuite Plug-ins

AudioSuite plug-ins can be applied to whole re-
gions, partial regions, or selections that are
made up of whole and partial regions across one
or more tracks.

When audio selected in the Edit window in-
cludes partial regions, the regions will automat-
ically be split into two or more regions when
they are processed. Processing will occur only
on the selection, leaving other regions un-
changed.

A Processing a locked region will cause the re-
gion to become unlocked, and processing a
muted region will cause it to become un-
muted. For more information on locked and
muted regions, refer to the Pro Tools Refer-
ence Guide.

Only audio files on locally connected hard
drives can be processed with AudioSuite plug-
ins. You cannot process audio files on remote
hard drives over a network (unless it is a Unity
network).

Selecting Tracks for AudioSuite
Processing

Because AudioSuite processes are performed on
the specific regions that you select, it is impor-
tant that you select only those regions, or parts
of regions, you actually want to process.

Selecting a region in the Audio Regions List will
automatically select it in a track (if it currently
resides on one). This is the default behavior for
Pro Tools. However, you can change this using
the Region Selection Follows Track Selection, or

Track Selection Follows Regions List Selection
options in the Editing page of the Preferences di-
alog. Refer to the Pro Tools Reference Guide for an
explanation of these Preferences.

A\ When processing a single audio channel
with an AudioSuite plug-in, make sure that
the plug-in is set to Mono mode, if available.

Selecting Tracks for Delay or Reverb
Processing

Because some AudioSuite effects such as delay
and reverb add additional material to the end of
the selected audio, it is important that you make
a selection that is longer than the original source
material so that the plug-in can write it to the
audio file. If you select only the original mate-
rial, without leaving additional space at the end,
any reverb decay or delay that occurs after the
end of the region will be cut off.

To compensate for this, place the region in a
track and select the desired audio plus an
amount of blank space at the end of the region
equal to the amount of delay or reverb decay
that you have added in the plug-in. The plug-in
will then have space at the end of the region in
which to write the final delay or decay. If you se-
lect more blank space than you need, you can
remove it using the Trimmer tool after applying
AudioSuite processing.

To process audio with an AudioSuite plug-in:

1 Select regions to process in one or more target
tracks and/or in the Audio Regions List. Shift-
click to select multiple regions. Only regions
that are selected will be processed.

2 Choose the desired AudioSuite plug-in from
the AudioSuite menu.

3 Click the Preview button to begin playback of
the selected material.
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4 Adjust the plug-in controls to achieve the ef-
fect that you want. These settings will determine
how the file is processed and what effect the
processing will have on the original regions. Fol-
low these guidelines:

e To process the selected region only in the
track in which it appears, select Playlist
from the Selection Reference pop-up. Alter-
natively, if you want to process the selected
region in the Audio Regions list only,
choose Region List from this pop-up.

e If you want to process and update every oc-
currence of the selected region throughout
your session, enable the Use In Playlist but-
ton (and also select Region List from the Se-
lection Reference pop-up). Alternatively, if
you do not want to update every occur-
rence of the selected region, deselect the
Use In Playlist button.

¢ To configure the plug-in for destructive
processing, select Overwrite Files from the
File Mode pop-up menu. This will over-
write and permanently modify the original
source audio files.

e Alternatively, to configure the plug-in for
nondestructive processing, select Create
Individual Files from the File Mode pop-up
menu. This will create new audio files that
have been processed with the AudioSuite
Plug-in and leave the original source audio
files untouched.

e [f you have selected multiple regions for
processing and want to create a new file
that connects and consolidates all of these
regions together, select Create Continuous
File from the File Mode pop-up menu.

5 Finally, when you are ready, click the Process
button.
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The selected audio is processed according to the
settings you have specified. Pro Tools appends
an acronym to the region’s name indicating the
AudioSuite process that has been applied. The
new audio files then appear in your session.

Using AudioSuite Plug-Ins in
Stereo

Some AudioSuite plug-ins can be used in either
mono or stereo. If you plan to use them in ste-
reo, be aware of the following:

o To process a mono track and obtain a stereo
result, select the desired track or region plus an
empty track or region. Then set the plug-in to
Stereo mode and select the Sum Inputs button
(if present) to center the dry signal. When you
process the audio, the result will be two tracks or
regions that represent the right and left chan-
nels of the processed audio. You should then
pan these tracks hard right and hard left in your
mix.

o Ifyouset a plug-in to Stereo mode, then select
an odd number of Pro Tools tracks for process-
ing (as opposed to an even number), the plug-in
will process the selected tracks in pairs, in stereo.
However, the last odd, unpaired track will be
processed as mono, using the left channel set-
tings of the stereo plug-in. If you want the last
track to be processed in stereo, you must select
an additional track to pair it with—an empty
one if necessary.

For more information, see “Channel Mode
Button” on page 37.



DigiRack Real-Time TDM and RTAS Plug-Ins

EQ I

The EQ III Plug-In provides a high-quality
7 Band, 2-4 Band, or 1 Band EQ for adjusting
the frequency spectrum of audio material.

EQ III is available in the following formats:
e 7 Band: TDM, RTAS, AudioSuite
e 2-4 Band: TDM and RTAS only
e 1 Band: TDM, RTAS, AudioSuite

EQ III supports all Pro Tools session sample
rates: 192 kHz, 176.4 kHz, 96 kHz, 88.2 kHz,
48 kHz, and 44.1 kHz. EQ III operates as a mono
or multi-mono plug-in only. Stereo and multi-
channel tracks are supported through multi-
mono operation.

EQ III can be operated from the following con-
trol surfaces:

e Digidesign D-Control

e Digidesign ProControl

¢ Digidesign Control|24

e Digidesign 002

e Digidesign Command|8

e Mackie HUI-compatible controllers

EQ III has a Frequency Graph display that shows
the response curve for the current EQ settings
on a two-dimensional graph of frequency and
gain. The frequency graph display also lets you
modify frequency, gain and Q settings for indi-
vidual EQ bands by dragging their correspond-
ing points in the graph.

By choosing from the 7 Band, 2-4 Band, or

1 Band versions of the EQ III plug-in, you can
use only the number of EQ bands you need for
each track, conserving DSP capacity on

Pro Tools|HD systems.

EQ 11l Configurations

The EQ III Plug-In appears as three separate
choices in the plug-in insert pop-up menu and
in the AudioSuite menu:

7 Band (“7-Band EQ 3”)
2-4 Band (“4-Band EQ 3”)
1 Band (“1-Band EQ 3”)

7 Band EQ and 2-4 Band EQ

The 7 Band EQ is available in TDM, RTAS, and
AudioSuite formats. The 2-4 Band EQ is avail-
able in TDM and RTAS formats only.
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The 7 Band EQ and the 2—-4 Band EQ share the
same window and identical controls, but with

the 2-4 Band EQ, a limited number of the seven
available bands can be active at the same time.

[ md  Ja]  vhwazes [ e | _
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7 Band EQ and 2-4 Band EQ window
1 Band EQ

The 1 Band EQ is available in TDM, RTAS, and
AudioSuite formats.

The 1 Band EQ has its own window, with six se-
lectable filter types.

1 Band EQ window
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EQ 11l Controls

Adjusting EQ lll Controls

You can adjust the EQ III plug-in controls by
any of the following methods:

Dragging Plug-In Controls

The rotary controls on the EQ III Plug-In can be
adjusted by dragging over them horizontally or
vertically. Dragging up or to the right incre-
ments the control. Dragging down or to the left
decrements the control.

W\ FREQ v@
[.J
Dragging a plug-in control

Typing Control Values

You can enter control values directly by clicking
in the corresponding text box, typing a value,
and pressing Enter (Windows) or Return (Mac-
intosh).

Typing a control value
Inverting Filter Gain

(Peak EQ Bands Only)

Gain values can be inverted on any Peak EQ
band by Shift-clicking its control dot in the Fre-
quency Graph display, or its Gain knob in the
plug-in window. This changes a gain boost to a
cut (+9 to -9) or a gain cut to a boost (-9 to +9).
Gain values cannot be inverted on Notch, High-
Pass, Low-Pass, or shelving bands.



Dragging in the Frequency Graph Display

You can adjust the following by dragging the
control points directly in the Frequency Graph
display:

Frequency Dragging a control point to the right
increases the Frequency setting. Dragging a con-
trol point to the left decreases the Frequency set-
ting.

Gain Dragging a control point up increases the
Gain setting. Dragging a control point down de-
creases the Gain setting.

Q Start-dragging (Windows) or Control-drag-
ging (Macintosh) a control point up increases
the Q setting. Start-dragging (Windows) or Con-
trol-dragging (Macintosh) a control point down
decreases the Q setting.

Dragging a control point in the Frequency Graph display
Adjusting Controls with Fine Resolution

Controls and control points can be adjusted
with fine resolution by holding the Control key
(Windows) or the Command key (Macintosh)
while adjusting the control.

Resetting Controls to Default Values

You can reset any on-screen control to its de-
fault value by Alt-clicking (Windows) or Option-
clicking (Mac OS) directly on the control or on
its corresponding text box.

Using Band-Pass Mode

You can temporarily set any EQ III control to
Band-Pass monitoring mode. Band-Pass mode
cuts monitoring frequencies above and below
the Frequency setting, leaving a narrow band of
mid-range frequencies. It is especially useful for
adjusting limited bandwidth in order to solo
and fine-tune each individual filter before re-
verting the control to notch filter or peaking fil-
ter type operations.

Q Band-Pass mode does not affect EQ Il Gain
" controls.

To switch an EQ lll control to Band-Pass mode:

e Hold Start+Shift (Windows) or Control+Shift
(Macintosh), and drag any rotary control or
control point horizontally or vertically.

EQ Ill interactive graph displaying Band-Pass mode

When monitoring in Band-Pass mode, the Fre-
quency and Q controls function differently.

Frequency Sets the frequency above and below
which other frequencies are cut off, leaving a
narrow band of mid-range frequencies.

Q Sets the width of the narrow band of mid-
range frequencies centered around the Fre-
quency setting.

To switch an EQ lll control out of Band-Pass mode:

e Release Start+Shift (Windows) or Con-
trol+Shift (Macintosh).
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Using a Control Surface

EQ III can be controlled from any supported
control surface, including Digidesign’s
D-Control, D-Command, ProControl, Con-
trol|24, Digi 002, or Command|8. Refer to the
guide that came with the control surface for de-
tails.

1/0 Controls

The following Input and Output controls are
found on all EQ III configurations, except where
noted otherwise.

Input and Output Meters

IN o Clip
<60 32 -22 16 10 6 3 o i
out -:'_ Indicators

=
Input

Polarity i
Output Gain
Control npyt Congrol
Gain
Control

1/0 controls and meters for 7 Band EQ and
2-4 Band EQ (top) and 1 Band EQ (bottom)

Input Gain Control

The Input Gain control sets the input gain of the
plug-in before EQ processing, letting you make
up gain or prevent clipping at the plug-in input
stage.

44 DigiRack Plug-Ins Guide

Output Gain Control
(7 Band EQ and 2-4 Band EQ Only)

The Output Gain control sets the output gain af-
ter EQ processing, letting you make up gain or
prevent clipping on the channel where the plug-
in is being used.

Input Polarity Control

The Input Polarity button inverts the polarity of
the input signal, to help compensate for phase
anomalies occurring in multi-microphone envi-
ronments, or because of mis-wired balanced
connections.

Input and Output Meters
(7 Band EQ and 2-4 Band EQ Only)
The plasma-style Input and Output meters show

peak signal levels before and after EQ process-
ing, and indicate them as follows:

Green Indicates nominal levels

Yellow Indicates pre-clipping levels, starting at
-6 dB below full scale

Red Indicates full scale levels (clipping)

The clip indicators at the far right of each meter
indicate clipping at the input or output stage of
the plug-in. Clip indicators can be cleared by
clicking the indicator.



EQ Band Controls

The individual EQ bands on each EQ III config-
uration have some combination of the follow-
ing controls, as noted below.

EQtype Q
selector

control

Band
Enable
Frequency
control button
Gain
control

EQ Band controls (7 Band EQ Low-Mid band shown)
EQ Type Selector

On the 1 Band EQ, the EQ Type selector lets you
choose any one of six available filter types:
High-Pass, Notch, High-Shelf, Low-Shelf, Peak,
and Low-Pass.

On the 7 Band EQ and the 2-4 Band EQ, the
HPF, LPF, LF, and HF sections have EQ Type se-
lectors to toggle between the two available filter
types in each section.

Band Enable Button
(7 Band EQ and 2-4 Band EQ Only)

The Band Enable button on each EQ band tog-
gles the corresponding band in and out of cir-
cuit. When a Band Enable button is highlighted,
the band is in circuit. When a Band Enable but-
ton is dark gray, the band is bypassed and avail-
able for activation. On the 2-4 Band EQ, when a
Band Enable button is light gray, the band is by-
passed and unavailable.

Band Gain Control

Each Peak and Shelf EQ band has a Gain control
for boosting or cutting the corresponding fre-
quencies. Gain controls are not used on High-
Pass, Low-Pass, or Notch filters.

Frequency Control

Each EQ band has a Frequency control that sets
the center frequency (Peak, Shelf and Notch
EQs) or the cutoff frequency (High-Pass and
Low-Pass filters) for that band.

Q Control

Peak and Notch On Peak and Notch bands, the
Q control changes the width of the EQ band.
Higher Q values represent narrower band-
widths. Lower Q values represent wider band-
widths.

Shelf On Shelf bands, the Q control changes the
Q of the shelving filter. Higher Q values repre-
sent steeper shelving curves. Lower Q values
represent broader shelving curves.

Band Pass On High-Pass and Low-Pass bands,
the Q control lets you select from any of the fol-
lowing Slope values: 6 dB, 12 dB, 18 dB, or

24 dB per octave.
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Frequency Graph Display
(7 Band EQ and 2-4 Band EQ Only)

The Frequency Graph display in the 7 Band EQ and the 2-4 Band EQ shows a color-coded control dot
that corresponds to the color of the Gain control for each band. The filter shape of each band is sim-
ilarly color-coded. The white frequency response curve shows the contribution of each of the enabled
filters to the overall EQ curve.

Low Mid High
control dot control dot control dot
(red) (yellow) (blue)

Frequency
response
curve

High-Pass Low-Mid High-Mid Low-Pass
control dot control dot control dot control dot
(gray) (brown) (green) (gray)

Frequency Graph display for the 7 Band EQ

1 Band EQ

The Frequency Graph display in the 1 Band EQ shows a control dot that indicates the center fre-
quency (Peak, Shelf and Notch Filters) or the cutoff frequency (High-Pass and Low-Pass filters) for the
currently selected filter type.

Control dot

=00
ET
Frequency @ 1000 H]

response
curve
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7 Band EQ

Input/Output Level
and
Polarity controls

High-Pass/
Low Notch

Low-Pass/
High Notch

=0 =0

Input/Output Level meters

— m
w.—-—l_.

Qe Qi il

-:.,@@-:,@ ) i) )
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Low Mid High
Shelf/Peak Peak Shelf/Peak

Low-Mid High-Mid
Peak Peak

7 Band EQ and 2-4 Band EQ window

Frequency Graph
Display

The 7 Band EQ has the following available bands: High-Pass/Low Notch, Low-Pass/High Notch, Low
Shelf/Low Peak, Low-Mid Peak, Mid Peak, High-Mid Peak, and High Shelf/High Peak.

All seven bands are available for simultaneous use. In the factory default setting, the High-Pass/Low
Notch and Low-Pass/High Notch bands are out of circuit, the Low Shelf and High Shelf bands are se-
lected and in circuit, and the Low-Mid Peak, Mid Peak, High-Mid Peak bands are in circuit.
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High-Pass/Low Notch

The High-Pass/Notch band is switchable be-
tween High-Pass Filter and Notch EQ functions.
By default, this band is set to High-Pass Filter.

High-Pass Filter Attenuates all frequencies below
the Frequency setting at the selected slope while
letting all frequencies above pass through.

Low-Notch EQ Attenuates a narrow band of fre-
quencies centered around the Frequency set-
ting. The width of the attenuated band is deter-

mined by the Q setting.

High-Pass Filter
button

Band
Enable
button

Low Notch EQ
button
Band
Enable
button

Low-Pass/High Notch

The Low-Pass/Notch band is switchable be-
tween Low-Pass Filter and Notch EQ functions.
By default, this band is set to Low-Pass Filter.

Low-Pass Filter Attenuates all frequencies above
the Frequency setting at the selected slope while
letting all frequencies below pass through.

High-Notch EQ Attenuates a narrow band of fre-
quencies centered around the Frequency set-
ting. The width of the attenuated band is deter-

mined by the Q setting.

Low-Pass Filter
button

Band
Enable
button

High Notch EQ
button

Band

Enable
button

Frequency Slope
control  control

Frequency Q
control  control

High-Pass filter (left) and Low Notch EQ (right)

The High Pass and Low Notch controls and their
corresponding graph elements are displayed on-

screen in gray.

High-Pass Filter and Low Notch EQ control values

Frequency Slope
control  control

Frequency Q
control  control

Low-Pass filter (left) and High Notch EQ (right)

The Low Pass and High Notch controls and their
corresponding graph elements are displayed on-

screen in gray.

Low-Pass Filter and High Notch EQ control values

Control

Value

Control

Value

Frequency Range

20 Hz to 8 kHz

Frequency Range

120 Hz to 20 kHz

Frequency Default

20 Hz

Frequency Default

20 kHz

HPF Slope Values

6, 12, 18, or 24 dB/oct

LPF Slope Values

6, 12, 18, or 24 dB/oct

Low Notch Q Range

0.1to0 10.0

High Notch Q Range

0.1to0 10.0

Low Notch Q Default

1.0

High Notch Q Default

1.0
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Low Shelf/Low Peak

The Low Shelf/Peak band is switchable between
Low Shelf EQ and Low Peak EQ functions. By de-
fault, this band is set to Low Shelf.

Low-Shelf EQ Boosts or cuts frequencies at and
below the Frequency setting. The amount of
boost or cut is determined by the Gain setting.
The Q setting determines the shape of the shelv-
ing curve.

Low Peak EQ Boosts or cuts a band of frequen-
cies centered around the Frequency setting. The
width of the affected band is determined by the
Q setting.

Low Shelf EQ Low Peak EQ
button button
Q Q
control control
Band Band
Enable Enable
button button
)
@)

control
Frequency Frequency
control control

Low Shelf EQ (left) and Low Peak EQ (right)

The Low Shelf and Low Peak Gain controls and
their corresponding graph elements are dis-

played on-screen in red.

Low Shelf EQ and Low Peak EQ control values

Control

Value

Frequency Range

20 Hz to 500 Hz

Frequency Default 100 Hz
Low Shelf Q Range 0.1t0 2.0
Low Peak Q Range 0.1to0 10.0
Q Default 1.0

Low Shelf Gain Range

-12 dB to +12 dB

Low Peak Gain Range

-18 dB to +18 dB
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Low-Mid Peak

The Low-Mid Peak band boosts or cuts frequen-
cies centered around the Frequency setting. The
width of the band is determined by the Q set-
ting.

Q

control

Band
Enable
Frequency
control button

Gain
control

Low-Mid Peak EQ

The Low-Mid Gain control and its correspond-
ing graph elements are displayed on-screen in
brown.

Low-Mid Peak EQ control values

Control Value

Mid Peak

The Mid Peak band boosts or cuts frequencies
centered around the Frequency setting. The
width of the band is determined by the Q set-
ting.

Q
control
Band
Enable
Frequency
control T |\ button
Gain
control
Mid Peak EQ

The Mid Gain control and its corresponding
graph elements are displayed on-screen in yel-
low.

Mid Peak EQ control values

Control Value

Frequency Range 40 Hz to 1 kHz

Frequency Default 200 Hz

Low-Mid Peak Q Range 0.1to0 10.0

Low-Mid Peak Q Default 1.0

Low-Mid Peak Gain Range | -18 dB to +18 dB
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Frequency Range 125 Hz to 8 kHz

Frequency Default 1 kHz
Mid Peak Q Range 0.1to0 10.0
Mid Peak Q Default 1.0

Mid Peak Gain Range -18 dB to +18 dB




High-Mid Peak

The High-Mid Peak band boosts or cuts frequen-
cies centered around the Frequency setting. The
width of the band is determined by the Q set-
ting.

Q

control

Band
. Enable
Frequency
control ‘ button
control
High-Mid Peak EQ

The High-Mid Gain control and its correspond-
ing graph elements are displayed on-screen in
green.

High-Mid Peak EQ control values

Control Value

Frequency Range 200 Hz to 18 kHz

Frequency Default 2 kHz
Mid Peak Q Range 0.1t0 10.0
Mid Peak Q Default 1.0

Mid Peak Gain Range -18 dB to +18 dB

High Shelf/High Peak

The High Shelf/Peak band is switchable between
High Shelf EQ and High Peak EQ functions. By
default, this band is set to High Shelf.

High-Shelf EQ Boosts or cuts frequencies at and
above the Frequency setting. The amount of
boost or cut is determined by the Gain setting.
The Q setting determines the shape of the shelv-
ing curve.

High Peak EQ Boosts or cuts a band of frequen-
cies centered around the Frequency setting. The
width of the affected band is determined by the
Q setting.

High Shelf EQ High Peak EQ
button button
Q Q
control control

Band
Enable
button

Band
Enable
button

Gain
control
Frequency Frequency

control control

High Shelf EQ (left) and High Peak EQ (right)

Gain
control

The High Shelf and High Peak Gain controls and
their corresponding graph elements are dis-
played on-screen in blue.

High Shelf EQ and High Peak EQ control values

Control Value

Frequency Range 1.8 kHz to 20 kHz

Frequency Default 6 kHz

High Shelf Q Range 0.1t0 2.0
High Peak Q Range 0.1to 10.0
Q Default 1.0

High Shelf Gain Range -12 dB to +12 dB

High Peak Gain Range -18 dB to +18 dB

Chapter 5: DigiRack Real-Time TDM and RTAS Plug-Ins

51



2-4 Band EQ

The 2-4 Band EQ uses the same plug-in window
as the 7 Band EQ, but on the 2-4 Band EQ, buta
limited number of the seven available bands can
be active at the same time.

In the factory default setting, the High-Pass/Low
Notch, Low-Pass/High Notch and Mid Peak
bands are out of circuit, the Low Shelf and High
Shelf bands are selected and in circuit, and the
Low-Mid Peak and High-Mid Peak bands are in
circuit.

Q For Pro Tools HD, using a 2-4 Band EQ in-
stead of a 7 Band EQ saves DSP resources.

Changing from 2-4 Band to 7 Band

After switching from a 2-4 band EQ to a 7 Band
EQ, or importing settings from a 2-4 Band EQ,
all control settings from the 2-4 Band EQ are
preserved, and the bands in the 7 Band EQ in-
herit their enabled or bypassed state from the
2-4 Band plug-in.

Additional EQ bands can then be enabled to add
them to the settings inherited from the
2-4 Band plug-in.

Filter Usage with 2-4 Band EQs

With a 2-4 Band EQ, a maximum of four filters
may be active simultaneously, with each of the
five Peak bands (Low Shelf/Peak, Low-Mid Peak,
Mid-Peak, High-Mid Peak and High Shelf/Peak)
counting as one filter. Each of the Band-pass
and Notch filters (High-Pass, Low Notch, Low-
Pass and High-Notch) counts as two filters.
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When any combination of these filter types uses
the four-filter maximum on the 2-4 Band EQ,
the remaining bands become unavailable. This
is indicated by the Band Enable buttons turning
light gray. When filters become available again,
the Band Enable button on inactive bands turns
dark gray.

Switching Between the 2-4 Band EQ
and 7 Band EQ

When you switch an existing EQ III plug-in be-
tween the 2-4 Band and 7 Band versions, or
when you import settings between versions, the
change is subject to the following conditions:

Changing from 7 Band to 2-4 Band

After switching from a 7 band EQ to a 2-4 Band
EQ, or importing settings from a 7 Band EQ, all
control settings from the 7 Band EQ are pre-
served in the 2-4 Band EQ, but all bands are
placed in a bypassed state.

Bands can then be enabled manually, up to the
2-4 Band EQ four-filter limit.

1 Band EQ

Input Level and

Polarity controls Frequency Graph

display

EQ Type
selector

1 Band EQ window

Gain, Freq and
Q controls



The 1 Band EQ may be set to any one of six EQ
types: High-Pass, Notch, High-Shelf, Low-Shelf,
Peak, and Low-Pass, by clicking the correspond-
ing icon in the EQ Type selector.

Band Controls

The individual EQ types have some combina-
tion of the following controls, as noted below.

1 Band EQ control values

Control Value

Frequency Range (All) 20 Hz to 20 kHz

Frequency Default (All) 1 kHz

Q Range (Low/High Shelf) 0.1t0 2.0
Q Range (Peak/Notch) 0.1t010.0
Q Default (All) 1.0

Gain Range (Low/High Shelf) | —-12 dB to +12 dB

High Peak Gain Range -18 dB to +18 dB

EQ Types

High-Pass Filter

The High-Pass filter attenuates all frequencies
below the Frequency setting at the selected rate
(6 dB, 12 dB, 18 dB, or 24 dB per octave) while
letting all frequencies above pass through. No
gain control is available for this filter type.

2, | bypas: AS
-E--- e e,

1 Band EQ set to High-Pass Filter

Notch Filter

The Notch Filter attenuates a narrow band of
frequencies centered around the Frequency set-
ting. No gain control is available for this EQ
type. The width of the attenuated band is deter-
mined by the Q setting.

1-Band E0 3
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1 Band EQ set to Notch Filter
High-Shelf EQ

The High-Shelf EQ boosts or cuts frequencies at
and above the Frequency setting. The amount of
boost or cut is determined by the Gain setting.
The Q setting determines the shape of the shelv-
ing curve.

Fudio B =]

“actory deraults

1 Band EQ set to High-Shelf EQ
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Low-Shelf EQ

The Low-Shelf EQ boosts or cuts frequencies at
and below the Frequency setting. The amount
of boost or cut is determined by the Gain set-
ting. The Q setting determines the shape of the
shelving curve.

1-Band EO 3 | bwpass
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1 Band EQ set to Low-Shelf EQ

Peak EQ

The Peak EQ boosts or cuts a band of frequencies
centered around the Frequency setting. The
width of the affected band is determined by the
Q setting.

([ oy | [ERED
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1 Band EQ set to Peak EQ
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Low-Pass Filter

The Low-Pass filter attenuates all frequencies
above the cutoff frequency setting at the se-
lected rate (6 dB, 12 dB, 18 dB, or 24 dB per oc-
tave) while letting all frequencies below pass
through. No gain control is available for this fil-
ter type.

1-Band E0 3 T

[ oot | - | +| @ compare | oo [ sate] AS)

1 Band EQ set to Low-Pass Filter

Automating EQ Il Controls

All EQ III plug-in controls can be automated in
Pro Tools.

To automate a control directly from the plug-in
window:

= Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click (Macintosh) the
control, and choose Enable Automation.

Enabling automation for a control

To automate multiple controls:

» Control-Alt-Start-click (Windows) or Com-
mand-Option-Control-click (Macintosh) the
control, choose Open Plug-In Automation Dia-
log, and choose the controls you want to auto-
mate.



The automation-enabled status of EQ III plug-in
controls is indicated by the colored LED be-
neath each on-screen knob and colored outlines
around each on-screen button.

Automation-enabled buttons

Automation-enabled knobs

Automation-enabled controls

Even if an EQ III band is bypassed, for example,
when the filter capacity of a 2-4 Band EQ is sur-
passed, its controls are still available for automa-
tion. This lets you continue to update settings in
a session in preparation for the next time the by-
passed band is enabled.

For complete instructions on automating
plug-ins in Pro Tools, see the Pro Tools
Reference Guide.

EQII

For information, see the electronic PDF guide
for the EQ II plug-ins.

Click

The Click plug-in creates an audio click during
session playback that you can use as a tempo ref-
erence when performing and recording. The
Click plug-in receives its tempo and meter data
from the Pro Tools application, enabling it to
follow any changes in tempo and meter in a ses-
sion. The Click plug-in is a mono-only plug-in.
Several click sound presets are included.
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Click plug-in
Click Controls

MIDI In LED Illuminates each time the Click
plug-in receives a click message from the
Pro Tools application, indicating the click
tempo.

Accented Controls the output level of the ac-
cent beat (beat 1 of each bar) of the audio click.

Unaccented Controls the output level of the un-
accented beats of the audio click.

To use the Click plug-in:

1 Choose Options > Click to enable the Click
option (or enable the Click button in the Trans-
port window).

2 Create a mono Auxiliary Input and insert the
Click plug-in.

3 Select a click sound preset.
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4 Choose Setup > Click and set the Click and
Countoff options as desired.

A The Note, Velocity, Duration, and Output
options in this dialog are for use with MIDI
instrument-based clicks and do not affect
the Click plug-in.

Click/Countoff Options

_Click

® During play and record
O only during record

O Only during countaff

Note Velocity Duration
Accented 3 127 100 ms
Unaccented 3 100 100 ms
Output "none )'3']
Ceuntoff
E Only during record Z Bars
)

Click Options dialog

Refer to the Pro Tools Reference Guide for
more information on configuring Click op-
tions.

5 Begin playback. A click is generated according
to the tempo and meter of the current session
and the settings in the Click/Countoff Options
dialog.
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Dither

The Dither plug-in is designed for reducing
quantization noise when mixing or fading low-
level audio signals during word size reduction to
16-, 18-, or 20-bits.

Q For more advanced dithering, use the Digi-
° Rack POW-r Dither plug-in. See “POW-r
Dither” on page 58.
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Dither plug-in

Dither is a form of randomized noise used to
minimize quantization artifacts in digital audio
systems. Quantization artifacts are most audible
when the audio signal is near the low end of its
dynamic range, such as during a quiet passage or
fade-out.

The introduction of dithering can reduce these
quantization artifacts with very low-level noise,
minimizing artifacts as audio reaches low level.
With dithering there is a trade-off between sig-
nal-to-noise performance and less-apparent arti-
facts. Proper use of dithering squeezes better
subjective performance out of 16-bits (or what-
ever the destination bit-depth).

The most common application of dithering is to
use it on a master output mix as the last proces-
sor in the signal path when preparing a 24-bit
session for CD mastering. In this case, you



would insert the Dither plug-in on a Master
Fader to reduce session bit-depth from 24-bits to
16-bits. The inserts on a Master Fader track are
always post-fader.

A Insert the Dither plug-in (or any dithering
plug-in, such as Dither, POW-r Dither, or
Maxim) on a Master Fader track when us-
ing Bounce to Disk to create a 16-bit file (or
any bit depth lower than 24-bit) from a 24-
bit session; otherwise the resulting 16-bit
file will be truncated at the destination bit
depth. For more information on Bounce to
Disk, refer to the Pro Tools Reference Guide.

The Dither plug-in has user-selectable bit resolu-
tion and a noise shaping on/off option.

Q If outputting 24-bit audio to an analog des-
" tination with a 96 1/0, or 192 I/O, you do
not need to use Dither. This allows maxi-
mum output fidelity from the high-perfor-
mance 24-bit digital-to-analog convertors
of the interfaces.

Noise Shaping

The Dither plug-in features a technique known
as noise shaping to further improve audio per-
formance and reduce perceived noise in low-
level signals. Noise shaping utilizes filtering to
reduce noise that falls in the middle of the audio
spectrum (specifically, around 4 kHz). This is the
range where human hearing is most sensitive.

In reality, since the noise plays an important
role in reducing quantization artifacts, the noise
is not reduced, rather it is shifted into a fre-
quency range where it is harder to hear. Essen-
tially, noise shaping lessens our perception of
the noise inherent in dithering schemes by
shifting audible noise components into a less
audible range.

Dither and Output Bit Resolution

Dither has two user-selectable settings for opti-
mizing its operation:

Bit Resolution

Use this pop-up menu to choose one of three
possible resolutions for the Dither processing.
As a general rule, set this control to the maxi-
mum bit resolution of your destination.

16-bit Recommended for output to digital de-
vices such as DAT recorders and CD recorders,
since they have a maximum resolution of 16-
bits.

18-bit Recommended for output to analog de-

vices if you are using an 18-bit audio interface,
such as the 888 I/O or 882 I/O audio interface;
this is the maximum resolution available from
the 18-bit digital-to-analog convertors of these
devices.

20-bit Recommended for output to digital de-
vices that support a full 20-bit recording data
path, such the Sony PCM-9000 optical master-
ing recorder, or the Alesis ADAT XT 20. Use this
setting for output to analog devices if you are us-
ing a 20-bit audio interface, such as the

882|20 I/0O audio interface. The 20-bit setting
can also be used for output to digital effects de-
vices that support 20-bit input and output, since
it provides for a lower noise floor and greater dy-
namic range when mixing 20-bit signals directly
into the TDM environment.
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If you want, you can choose not to use the
Dither plug-in and instead utilize the full 24-bit
resolution of Pro Tools’ digital output, depend-
ing on your destination device. If you are using
a 24-bit audio interface (such as the 192 I/0O,
96 1/0, or 888|24 1/0) and are outputting audio
to an analog destination, we recommend that
you do not use dither.

A The DigiRack Dither plug-in only provides
eight channels of uncorrelated dithering
noise. If DigiRack Dither is used on more
than eight tracks, the dithering noise begins
to repeat and dither performance is im-
paired. For example, if two Quad DigiRack
Dithers are used, both Quad instances of
Dither will have all of their dither noise un-
correlated. However, any additional in-
stances of the Dither plug-in will begin to
repeat the dithering noise.

Noise Shaping

This button engages or disengages Noise Shap-
ing. Noise shaping is on when the button is
highlighted in blue. See “Noise Shaping” on
page 57 for more information.

Refer to the Pro Tools Reference Guide for
details on using the Dither plug-in during
mixdown.

POW:-r Dither
(Pro Tools HD and Pro Tools LE Only)

The POW-r Dither plug-in is an advanced type
of dither that provides optimized word length
reduction. It is designed for final-stage critical
mixdown and mastering tasks where the highest
possible fidelity is desired when reducing bit
depth. For more information on dithering, see
“Dither” on page 56.
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POW:-r Dither plug-in

A\ The POW-r Dither plug-in does not run on
third party applications that use DAE.

A\ The multichannel TDM version of the
POW-r Dither plug-in is not supported at
192 kHz. Use the multi-mono TDM or
RTAS version instead.

POW-r Dither Controls

Bit Resolution

Use this pop-up menu to choose either 16- or
20-bit resolutions for POW-r Dither processing.
Set this control to the maximum bit resolution
of your destination.

16-bit Recommended for output to devices with
a maximum resolution of 16-bits, such as DAT
and CD recorders.

20-bit Recommended for output to devices that
support a full 20-bit recording data path.

Noise Shaping

Noise shaping improves audio performance and
lessens our perception of the noise inherent in
dithering schemes by shifting audible noise
components into a less audible range.



A\ The POW-r Dither plug-in is not appropri-
ate for truncation stages that are likely to be
further processed. It is recommended that
POW-r Dither be used only as the last insert
in the signal chain (especially when using
Type 1 Noise Shaping).

The POW-r Dither plug-in provides three types
of noise shaping, each with its own characteris-
tics. Try each noise shaping type and choose the
one that adds the least amount of coloration to
the audio being processed.

Type 1 Has the flattest frequency spectrum in
the audible range of frequencies, modulating
and accumulating the dither noise just below
the Nyquist frequency. Recommended for less
stereophonically complex material such as solo
instrument recordings.

Type 2 Has a psychoacoustically optimized low
order noise shaping curve. Recommended for
material of greater stereophonic complexity.

Type 3 Has a psychoacoustically optimized high
order noise shaping curve. Recommended for
full-spectrum, wide-stereo field material.

Refer to the Pro Tools Reference Guide for
details on using the Dither plug-in.

D-Verb

D-Verb is a studio-quality reverb provided in
TDM, RTAS, and AudioSuite formats.

A\ The TDM version of the D-Verb plug-in is
not supported at 192 kHz; use the RTAS
version instead.

D-Verb Controls
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D-Verb plug-in
Output Meter

The Output Meter indicates the output level of
the processed signal. With the stereo version of
D-verb, it represents the summed stereo output.
It is important to note that this meter indicates
the output level of the signal—not the input
level. If this meter clips, it is possible that the
signal clipped on input before it reached
D-Verb. Monitor your send or insert signal levels
closely to help prevent this from happening.

Clip Indicator

The Clip Indicator shows if clipping has oc-
curred. It is a clip-hold indicator. If clipping oc-
curs at any time during audio playback, the clip
lights remain on. To clear the clip indicator,
click it. With longer reverb times there is a
greater likelihood of clipping occurring as the
feedback element of the reverb builds up and ap-
proaches a high output level. See also “Clip In-
dicators” on page 15.
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Input Level

The Input Level slider adjusts the input volume
of the reverb to prevent the possibility of clip-

ping and/or increase the level of the processed
signal.

Mix

The Mix slider adjusts the balance between the
dry signal and the effected signal, giving you
control over the depth of the effect. This control
is adjustable from 100% to 0%.

Algorithm

This control selects one of seven reverb algo-
rithms: Hall, Church, Plate, Room 1, Room 2,
Ambience, or Nonlinear. Selecting an algorithm
changes the preset provided for it. Switching the
Size setting changes characteristics of the algo-
rithm that are not altered by adjusting the decay
time and other user-adjustable controls. Each of
the seven algorithms has a distinctly different
character:

Hall A good general purpose concert hall with a
natural character. It is useful over a large range
of size and decay times and with a wide range of
program material. Setting Decay to its maxi-

mum value will produce infinite reverberation.

Church A dense, diffuse space simulating a
church or cathedral with a long decay time,
high diffusion, and some pre-delay.

Plate Simulates the acoustic character of a
metal plate-based reverb. This type of reverb
typically has high initial diffusion and a rela-
tively bright sound, making it particularly good
for certain percussive signals and vocal process-
ing. Plate reverb has the general effect of thick-
ening the initial sound itself.
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Room 1 A medium-sized, natural, rich-sounding
room that can be effectively varied in size be-
tween very small and large, with good results.

Room 2 A smaller, brighter reverberant charac-
teristic than Room 1, with a useful adjustment
range that extends to “very small.”

Ambient A transparent response that is useful for
adding a sense of space without adding a lot of
depth or density. Extreme settings can create in-
teresting results.

Nonlinear Produces a reverberation with a natu-
ral buildup and an abrupt cutoff similar to a
gate. This unnatural decay characteristic is par-
ticularly useful on percussion, since it can add
an aggressive characteristic to sounds with
strong attacks.

Size

The Size control, in conjunction with the Algo-
rithm control, adjusts the overall size of the re-
verberant space. There are three sizes: Small,
Medium, and Large. The character of the rever-
beration changes with each of these settings (as
does the relative value of the Decay setting). The
Size buttons can be used to vary the range of a
reverb from large to small. Generally, you
should select an algorithm first, and then
choose the size that approximates the size of the
acoustic space that you are trying to create.

Diffusion

Diffusion sets the degree to which initial echo
density increases over time. High settings result
in high initial build-up of echo density. Low set-
tings cause low initial buildup. This control in-
teracts with the Size and Decay controls to affect
the overall reverb density. High settings of diffu-
sion can be used to enhance percussion. Use low
or moderate settings for clearer and more natu-
ral-sounding vocals and mixes.



Decay

Decay controls the rate at which the reverb de-
cays after the original direct signal stops. The
value of the Decay setting is affected by the Size
and Algorithm controls. This control can be set
to infinity on most algorithms for infinite re-
verb times.

Pre-Delay

Determines the amount of time that elapses be-
tween the original audio event and the onset of
reverberation. Under natural conditions, the
amount of Pre-Delay depends on the size and
construction of the acoustic space, and the rela-
tive position of the sound source and the lis-
tener. Pre-Delay attempts to duplicate this phe-
nomenon and is used to create a sense of
distance and volume within an acoustic space.
Long Pre-Delay settings place the reverberant
field behind rather than on top of the original
audio signal.

Hi Frequency Cut

Hi Frequency Cut controls the decay character-
istic of the high frequency components of the
reverb. It acts in conjunction with the Low-Pass
Filter control to create the overall high fre-
quency contour of the reverb. When set rela-
tively low, high frequencies decay more quickly
than low frequencies, simulating the effect of air
absorption in a hall. The maximum value of this
control is Off (which effectively means bypass).

Low-Pass Filter

Low-Pass Filter controls the overall high fre-
quency content of the reverb by setting the fre-
quency above which a 6 dB per octave filter at-
tenuates the processed signal. The maximum
value of this control is Off (which effectively
means bypass).

Dynamics i

There are five types of DigiRack Dynamics pro-
cessors: Compressor, Limiter, Gate, Ex-
pander/Gate and DeEsser.

Compressor Il
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The Compressor reduces the dynamic range of
signals that exceed a selected threshold by a spe-
cific amount. The increase of input signal
needed to cause a 1 dB increase in the output
signal of the compressor is called the compres-
sion ratio. For example, with a ratio of 4:1, an
8 dB increase of input produces a 2 dB increase
in the output.

Audio material often varies in loudness, and can
be above the threshold at one moment and be-
low it the next. The Attack slider sets the com-
pressor’s response time, or attack. The Release
slider sets the amount of time that it takes for
the compressor’s gain to return to its original
level.
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Using Compression Effectively

To use compression most effectively, the attack
time should be set so that signals exceed the

threshold level long enough to cause an increase
in the average level. This helps ensure that gain
reduction doesn’t decrease the overall volume.

Release times should be set long enough that if
signal levels repeatedly rise above the threshold,
they cause gain reduction only once. If the re-
lease time is too long, a loud section of the audio
material could cause gain reduction that persists
through a soft section. Of course, compression
has many creative uses that break these rules.

The Compressor has built-in metering that
shows the amount of gain reduction taking
place. The gain reduction meter usually remains
at 0 level when the input signal is below the
threshold and falls to the left to show the
amount of gain reduction in decibels when the
input signal exceeds the threshold.

Compressor Controls

Phase Invert Inverts the phase (polarity) of the
input signal to change frequency response char-
acteristics between multi-miked sources or to
correct for miswired microphone cables.

Phase Invert

Gain Provides overall output gain adjustment
for compensating for heavily compressed sig-
nals.

Input Meter Indicates the level of the unproc-
essed input signal to the Compressor.

Output Meter Indicates the output level of the
Compressor, including any gain compensation
added with the Gain control.
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Reduction Indicates the amount of gain reduc-
tion in dB.

Threshold Sets the threshold level. Signals that
exceed this level will be compressed. Signals
that are below it will be unaffected. A level set-
ting of 0 dB is equivalent to no compression.

Unlike scales on analog compressors, metering
scales on a digital device reflect a O dB value that
indicates full scale (fs)—the full-code signal
level. There is no headroom above 0 dB.

Ratio Sets the compression ratio. The range is
based on decibels above the threshold. For ex-
ample, if this is set to 2:1, it will compress
changes in signals above the threshold by one
half.

Attack Sets the Compressor’s attack time. The
smaller the value, the faster the attack. The
faster the attack, the more rapidly the Compres-
sor applies attenuation to the signal. If you use
fast attack times and heavy limiting, you should
generally use a proportionally longer release
time, particularly with material that contains
many peaks in close proximity.

Release Controls how long it takes for the Com-
pressor to be fully deactivated after the input
signal drops below the threshold level. In gen-
eral, if you use heavy compression, you should
use proportionally longer release times in order
to avoid pumping that may occur when the
Compressor is forced to jump back and forth be-
tween compressed and uncompressed signal
levels. Lengthening the release time will help
smooth these changes in level by introducing a
lag in the ramp-up/down time of attenuation.
Use shorter release times on material with fewer
peaks that do not occur in close proximity to
each other.



Knee Sets the rate at which the compressor
reaches full compression once the threshold has
been exceeded. This control ranges from 0
(hardest response) to 200 (softest response).

Graph Displays the response curve set by the
Compressor’s Threshold, Ratio, and Knee set-
tings. As you adjust these controls, refer to the
graph to see how the shape of this curve change.

LFE Enable Enables plug-in processing of the
LFE (low frequency effects) channel on a multi-
channel track formatted for 5.1, 6.1, or 7.1 sur-
round formats on some plug-ins. To disable LFE
processing, deselect this button. For more infor-
mation on the LFE channel, refer to the Pro Tools
Reference Guide.

External Key Enables and disables side-chain
processing. Side-chain processing uses the vary-
ing amplitude of a separate reference track to
trigger compression. See “Using the Side-Chain
Input” on page 20.

Key Listen When enabled, this lets you listen to
the reference track controlling the side-chain in-
put. This is useful for fine tuning the Compres-
sor’s settings to the Key Input. Key Listen audi-
tions the right audio channel on RTAS and
AudioSuite versions of the Compressor.

A\ Key Listen is not saved with the other plug-
in settings.
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The Limiter is used to prevent signal peaks from
ever exceeding a chosen level so that they don’t
overload amplifiers or recording devices. Most
limiters have ratios of 10:1 or 20:1, although
some provide ratios of up to 100:1. Large ratios
effectively limit the dynamic range of the signal
to a specific value by setting an absolute ceiling
for the dynamic range.

The Limiter’s ratio is internally set to 100:1, and
the Attack time defaults to 1 millisecond. The
Limiter is similar to heavy compression. It can
be useful for reducing pops and clicks, or for
hard-limiting dynamic range for broadcast or
band-limited mediums such as cassette.

Limiting is used to prevent short-term peaks
from reaching their full amplitude. Used judi-
ciously, limiting produces higher average levels,
while avoiding overload (clipping or distortion),
by limiting only some short-term transients in
the source audio. To prevent the ear from hear-
ing the gain changes, extremely short attack and
release times are used.
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Limiting is used to remove only occasional
peaks because gain reduction on successive
peaks would be noticeable. If audio material
contains many peaks, the threshold should be
raised and the gain manually reduced so that
only occasional, extreme peaks are limited.

Limiter Controls

Phase Invert Inverts the phase (polarity) of the
input signal to change frequency response char-
acteristics between multi-miked sources or to
correct for miswired microphone cables.

Gain Provides overall output gain adjustment.

Input Meter Indicates the level of the unproc-
essed input signal to the Limiter.

Output Meter Indicates the output level of the
Limiter, including any gain compensation
added with the Gain control.

Reduction Indicates the amount by which the
signal is being attenuated.

Threshold Sets the threshold level. Signals that
exceed this level will be limited. Signals that are
below it will be unaffected.

Attack Sets the Limiter’s attack time. The
smaller the value, the faster the attack. The
faster the attack, the more rapidly the Limiter
applies attenuation to the signal. If you use fast
attack times and heavy limiting, you should
generally use a proportionally longer release
time, particularly with material that contains
many peaks in close proximity.

64 DigiRack Plug-Ins Guide

Release Controls how long it takes for the Lim-
iter to be fully deactivated after the input signal
drops below the threshold level. In general, if
you use heavy limiting, you should use propor-
tionally longer release times in order to avoid
pumping that may occur when the Limiter is
forced to jump back and forth between limited
and unlimited signal levels. Lengthening the re-
lease time will help smooth these changes in
level by introducing a lag in the ramp-up/down
time of attenuation. Use shorter release times on
material with fewer peaks that do not occur in
close proximity to each other.

Graph Displays the response curve set by the
Limiter’s Threshold setting. As you adjust these
controls, refer to the graph to see how the shape
of this curve changes.

LFE Enable Enables plug-in processing of the
LFE (low frequency effects) channel on a multi-
channel track formatted for 5.1, 6.1, or 7.1 sur-
round formats on some plug-ins. To disable LFE
processing, deselect this button. For more infor-
mation on the LFE channel, refer to the Pro Tools
Reference Guide.

External Key Enables and disables side-chain
processing. Side-chain processing uses the vary-
ing amplitude of a separate reference track to
trigger limiting. See “Using the Side-Chain In-
put” on page 20.

Key Listen When enabled, this lets you listen to
the reference track controlling the side-chain in-
put. This is often useful for fine tuning the Lim-
iter’s settings to the Key Input. Key Listen audi-
tions the right audio channel on RTAS and
AudioSuite versions of the Limiter.

A\ Key Listen settings are not saved with other
plug-in settings.
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The Gate (also known as a noise gate) lets a sig-
nal above the selected threshold pass through to
the output at unity gain, without dynamic pro-
cessing. Once the input signal falls below the
threshold level, the gating shuts down the sig-
nal by fully or partially attenuating the output.
In this way, the desired signal is allowed to pass,
but unwanted signal is not. The Gate is useful
for noise removal on individual tracks, and can
be used for special effects such as cutting off a re-
verb tail.

Gate Controls

Phase Invert Inverts the phase (polarity) of the
input signal to change the frequency response
characteristics between multi-miked sources or
to correct for miswired microphone cables.

Gating Indicates the amount of reduction in dB.

Threshold Sets the threshold level. Signals that
exceed this level will pass through. Signals that
are below it will be gated, depending on the set-
tings of the Attack, Hold, Decay, and Range con-
trols (explained below).

Attack Sets the attack time of the Gate.

Hold Specifies a duration (in seconds or millisec-
onds) that the Gate will stay open after the ini-
tial attack cycle. This can be used as a one-shot
function to keep the Gate open for longer peri-
ods of time with a single crossing of the thresh-
old. It can also be used to prevent gate chatter
that may occur if varying input levels near the
threshold cause the Gate to open and close very
rapidly.

Decay Controls how long it takes for the Gate to
close after the signal falls below the threshold
level.

Range Sets the depth of the Gate when closed. It
has a maximum depth of —-80 dB. Setting the
gate to higher range levels allows more of the
gated audio that falls below the threshold to
peek through the gate at all times. This is useful
for things such as drum leakage, where you may
want to suppress the overall drum kit sound by
a specific amount, while emphasizing the gated
instrument such as a snare.

Graph Displays the response curve set by the
Gate’s Threshold and Range settings. As you ad-
just these controls, refer to the graph to see how
the shape of this curve changes.

External Key Enables and disables side-chain
processing. Side-chain processing uses the vary-
ing amplitude of a separate reference track to
trigger limiting. See “Using the Side-Chain In-
put” on page 20.

Key Listen When enabled, this lets you listen to
the reference track controlling the side-chain in-
put. This is often useful for fine tuning the
Gate’s settings to the Key Input.

A\ Key Listen is not saved with the other plug-
in settings.
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Expander/Gate Il
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Expander/Gate Il plug-in

The Expander/Gate reduces noise by decreasing
the gain of signals that fall below a user-select-
able threshold. Expanders are particularly useful
for reducing noise or signal leakage that creeps
into recorded material as its level falls, as often
occurs in the case of headphone leakage.

Expanders can be thought of as soft noise gates
since they provide a gentler way of cutting off
noisy low-level signals than the typically abrupt
cutoff of a gate. If you want, however, you can
actually use this plug-in as a gate, simply by set-
ting the Ratio to its maximum value and using
short attack, decay, and release settings.

Expander/Gate Controls

Phase Invert Inverts the phase (polarity) of the
input signal to change the frequency response
characteristics between multi-miked sources or
to correct for miswired microphone cables.

Reduction Meter Indicates the amount of signal
reduction in dB.
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Threshold Sets the threshold level. Signals that
fall below the threshold will be reduced in gain.
Signals that are above it will be unaffected.
(When adjusting the Threshold slider be sure
that audio material is playing through the Ex-
pander/Gate to see changes reflected in the Re-
duction meter.)

Ratio Sets the amount of expansion. For exam-
ple, if this is set to 2:1, it will lower signals below
the threshold by one half. At higher ratio levels
(such as 30:1 or 40:1) the Expander/Gate func-
tions like a gate by reducing lower level signals
much more dramatically. As you adjust the ratio
control, refer to the built-in graph to see how
the shape of the expansion curve changes.

Attack Sets the Expander’s attack time. This de-
termines how quickly a signal’s level is reduced
once it falls below the threshold. Use this along
with the Ratio setting to control how soft the
Expander’s gain reduction curve is.

Hold Specifies a duration (in seconds or millisec-
onds) that the Expander/Gate will stay open af-
ter the initial attack cycle. This can be used as a
one-shot function to keep the Expander/Gate
open for longer periods of time with a single
crossing of the threshold. It can also be used to
prevent gate chatter that may occur if varying
input levels near the threshold cause the gate to
open and close very rapidly.

Decay Controls how long it takes for the gate to
close after the input signal falls below the
threshold level and the hold time has passed.

Range Sets the depth of the gate when closed. It
has a maximum depth of —-80 dB. Setting the
gate to higher range levels allows more and
more of the gated audio that falls below the
threshold to peek through the gate at all times.



Key HPF This is a high-pass filter that removes
low frequencies in the Key Input signal. Use this
to define a specific frequency range of the Key
Input to trigger the Expander/Gate. A typical
use for this feature is to filter a drum track used
as a Key Input so that only specific high fre-
quencies (such as a snare drum) will open the
Gate.

Key LPF This is a low-pass filter that removes
high frequencies in the Key Input signal. Use
this to define a specific frequency range of the
Key Input to trigger the Expander/Gate. A typi-
cal use for this feature is to filter a drum track
used as a Key Input so that only specific low fre-
quencies (such as a kick drum or tom) trigger the
Expander/Gate. The maximum value for Key
LPF is Off. This lets the Key Input to pass
through without limiting its high-frequency
bandwidth.

Graph Displays the response curve set by the Ex-
pander/Gate’s Threshold, Ratio, and Range set-
tings. As you adjust these controls, refer to the
graph to see how the shape of this curve
changes.

LFE Enable Enables plug-in processing of the
LFE (low frequency effects) channel on a multi-
channel track formatted for 5.1, 6.1, or 7.1 sur-
round formats on some plug-ins. To disable LFE
processing, deselect this button. For more infor-
mation on the LFE channel, refer to the Pro Tools
Reference Guide.

External Key Enables and disables side-chain
processing. Side-chain processing allows the Ex-
pander/Gate to listen to the varying amplitude
of a separate reference track and use it to trigger
expansion. See “Using the Side-Chain Input” on
page 20.

Key Listen When enabled, this allows you to lis-
ten to the reference track controlling the side-
chain input. This is often useful for fine tuning
the Expander/Gate’s settings to the Key Input.

A\ Key Listen is not saved with the other plug-
in settings.
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DeEsser plug-in

The DeEsser reduces sibilants (“s,” “sh,” and “t”
sounds) and other high frequency noises that
can occur in vocals, voice-overs, and wind in-
struments such as flutes. These sounds can cause
peaks in an audio signal and lead to distortion.

The DeEsser reduces these unwanted sounds us-
ing fast-acting compression. A Threshold con-
trol sets the level above which compression
starts, and a Frequency control sets the fre-
quency band in which the DeEsser operates.

A\ The DeEsser is a monophonic-only plug-in.

Using De-essing Effectively

To use de-essing most effectively, insert the
DeEsser before compressor or limiter plug-ins.

Because too much de-essing can make audio ma-
terial sound lifeless, it is best used on individual
tracks rather than entire mixes.
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The Frequency slider should be set to remove
sibilants (typically the 4-10 kHz range) and not Mod Delay n
other parts of the signal. This helps prevent de-
essing from changing the original character of
the audio material.

The DigiRack Mod Delay II plug-ins provide
time delay-based effects such as echo, slap echo,
doubling, chorusing, and flanging. Mod Delay IT

Similarly, Threshold should be set high enough supports sample rates up to 192 kHz.
that de-essing is triggered only by sibilants. If
the Threshold is set too low, a loud, non-sibilant
section of audio material could cause unwanted
gain reduction or cause sibilants to be over at-

A\ Pro Tools 7.0 supports the original Mod De-
lay plug-in, but it is recommended that you
only use Mod Delay II for all new sessions.
Use Mod Delay (located in the Additional

tenuated, Files folder) only for compatibility with ex-
To improve de-essing of material that has both isting sessions. If you do not need to use
very loud and very soft passages, automate the Mod Delay, move it into the Plug-Ins (Un-
Threshold control so that it is lower on soft sec- used) folder. Mod Delay settings can be im-
tions. ported into Mod Delay II.

DeEsser Controls Mod Delay I

Input Meter Indicates the level of the unproc-
essed input signal to the DeEsser.

[5]
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Output Meter Indicates the output level of the
DeEsser.

Reduction Indicates the amount of gain reduc-
tion in dB. It remains at O dB level when the in-
put signal is below the threshold.

Threshold Sets the threshold level. Signals that
exceed this level will be compressed. Signals

that are below it will be unaffected. A setting of veren  HEV/E [o](J][J][D]
0 dB is equivalent to no de-essing. croove [ 1

Frequency Sets the frequency band in which the NOD DELAY Il
DeEsser operates. Frequencies in the specified
range will be gain reduced. To find the optimum
Frequency setting, sweep this control back and
forth during audio playback.

Mod Delay Il plug-in (Long Delay shown)

Key Listen Monitors the sibilant peaks used by
the DeEsser as a Key Input to trigger compres-
sion. This is useful for listening only to the sibi-
lance and fine tuning settings to remove them.
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There are five different Mod Delay II plug-ins,
capable of different maximum delay times:

e The Short Delay provides 43 ms of delay at all
sample rates.

e The Slap Delay provides 171 ms of delay at all
sample rates.

A\ Short Delay and Slap Delay do not have
Tempo, Meter, Duration, and Groove con-
trols.

e The Medium Delay provides 341 ms of delay
at all sample rates.

e The Long Delay provides 683 ms of delay at
all sample rates.

e The Extra Long Delay provides 2.73 seconds
of delay at all sample rates.

A\ The TDM versions of the Extra Long Delay
mono-to-stereo and stereo plug-in are not
supported at 96 kHz. All TDM versions of
the Extra Long Delay plug-in are not sup-
ported at 192 kHz. RTAS versions of the Ex-
tra Long Delay plug-in are fully supported
at all sample rates.

Mod Delay Il Controls

Input Controls the input volume of the delay to
prevent clipping.

Mix Controls the balance between the delayed
signal (wet) and the original signal (dry). If you
are using a delay for flanging or chorusing, you
can control the depth of the effect somewhat
with the Mix setting.

LPF (Low-Pass Filter) Controls the cutoff fre-
quency of the Low-Pass Filter. Use the LPF set-
ting to attenuate the high frequency content of
the feedback signal. The lower the setting, the

more high frequencies are attenuated. The max-
imum value for LPF is Off. This lets the signal
pass through without limiting the bandwidth of
the plug-in.

Delay Sets the delay time between the original
signal and the delayed signal.

Depth Controls the depth of the modulation ap-
plied to the delayed signal.

Rate Controls the rate of modulation of the de-
layed signal.

Feedback Controls the amount of feedback ap-
plied from the output of the delay back into its
input. It also controls the number of repetitions
of the delayed signal. Negative feedback settings
give a more intense “tunnel-like” sound to
flanging effects.

Tempo Sync Tempo Sync provides a direct con-
nection between session tempo and plug-in pa-
rameters that support MIDI Beat Clock. This di-
rect connection lets plug-in parameters such as
delay, auto-pan, and other time-domain effects
automatically synchronize to, and follow
changes in, session tempo. For plug-ins that do
not support Tempo Sync, the original MIDI Beat
Clock window (Setup > MIDI > MIDI Beat Clock)
remains available in Pro Tools.

A\ Tempo Sync is not available in plug-ins
with which it would limit functionality. For
example, for the Virus Indigo and
IndigoV40 plug-in, use the Pro Tools MIDI
Beat Clock window (Setup > MIDI > MIDI
Beat Clock). See the Pro Tools Reference
Guide for more information.

For more information, see “Tempo Sync” on
page 21.
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Tempo Available in some plug-ins that do not
support Tempo Sync, Tempo selects the desired
tempo in beats per minute (bpm). This setting is
independent of Pro Tools’ tempo. When a spe-
cific Duration is selected (see “Duration” be-
low), moving this control will affect the Delay
setting. Likewise, the range of both controls will
be limited to the maximum available delay with
the currently selected Duration. To enter very
short or long delays it may be necessary to dese-
lect all Duration buttons.

Q Use Event > Identify Beat or Event > Beat
Detective to determine the tempo. For more
information about Identify Beat and Beat
Detective refer to the Pro Tools Reference
Guide.

Meter Use this to enter either simple or com-
pound time signatures. The Meter control de-
faults to a 4/4 time signature.

Duration Specifies a desired delay from a musical
perspective. Enter the desired delay by selecting
appropriate note value (whole note, half note,
quarter note, eight note, or sixteenth note). Se-
lect the Dot or Triplet modifier buttons to dot
the selected note value or make it a triplet. For
example, selecting a quarter note and then se-
lecting the dot indicates a dotted quarter note,
and selecting an eighth note and then selecting
the triplet indicates a triplet eight note.

tempo  [IIKEE L
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Duration Triplet modifier Dot modifier

Tempo, Meter, Duration, and Groove controls
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Groove Provides fine adjustment of the delay in
percentages of a 1:4 subdivision of the beat. It
can be used to add “swing” by slightly offsetting
the delay from the precise beat of the track.

A It is not possible to exceed the maximum
delay length for a particular version of Mod
Delay II. Consequently, when adjusting any
of the tempo controls (Tempo, Meter, Dura-
tion, and Groove) you may not be able to
adjust the control across its full range. If
you encounter this behavior, switch to a
version of Mod Delay II that has a longer
delay time (for example, switch from Me-
dium Delay to Long Delay).

Multichannel Mod Delay Il

The Tempo and Meter controls are linked on
multichannel versions of Mod Delay II. Each
channel has its own Duration and Groove con-
trols, but the Tempo and Meter controls are glo-
bal.

Tempo, Meter, Duration, and Groove controls for a
stereo instance of Mod Delay Il

Signal Generator

The Signal Generator plug-in produces audio
test tones in a variety of frequencies, waveforms,
and amplitudes. It is particularly useful for gen-
erating reference signals with which to calibrate
Pro Tools|HD interfaces (such as the 96 I/O or
192 1/0) and other elements of your studio.

Refer to the Pro Tools|HD Getting Started
Guide for instructions on using Signal Gen-
erator to calibrate the 96 1/0, or 192 I/O
audio interfaces, as well as older audio in-
terfaces.
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Signal Generator plug-in

Q The TDM Signal Generator produces a tone
~as soon as it is inserted on a track. To mute
the Signal Generator, use the Bypass button.
When using the RTAS version of Signal
Generator, start playback to generate.

Signal Generator Controls

Frequency Sets the frequency of the signal in
hertz. Values range from a low of 20 Hz to a
high of 20 kHz in a 44.1 kHz session. The upper
limit of the frequency range for this setting will
increase to match the Nyquist frequency (half the
sample rate) in 96 kHz and 192 kHz sessions
(HD-series systems only).

Level Sets the amplitude of the signal in deci-
bels. Values range from a low of -95 dB to a high
of 0.0 dB.

Signal These buttons select the waveform.
Choices are sine, square, sawtooth, triangle,
white noise, and pink noise.

A\ The Signal Generator plug-in is not in-
tended for rigorous test purposes; it is a sim-
ple level calibration tool.

Peak Generates signal at the maximum possible
level without clipping.

RMS Generates signal at levels consistent with
the RMS (Root-Mean-Square) value, or the effec-
tive average level of the signal.

Pitch
(Pro Tools HD Only)

The Pitch plug-in is designed for a variety of au-
dio production applications ranging from pitch
correction of musical material to sound design.
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Pitch processing uses the technique of varying
sample playback rate to achieve pitch transposi-
tion. Because changing audio sample playback
rate results in the digital equivalent of vari-
speeding with tape, this is an unsatisfactory
method since it changes the overall duration of
the material.

Pitch transposition with the Pitch plug-in in-
volves a much more complex technique: digi-
tally adding or subtracting portions of the audio
waveform itself, while using de-glitching cross-
fades to minimize undesirable artifacts. The re-
sult is a processed signal that is transposed in
pitch, but still retains the same overall length as
the original, unprocessed signal.

Q The Pitch plug-in was formerly called

- DPP-1. It is fully compatible with all set-
tings and presets created for DPP-1.
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Pitch Controls

Input Level Attenuates the input level of the
Pitch plug-in to help prevent internal clipping.

Signal Present Indicator LED Indicates the pres-
ence of an input signal.

Clip Indicator Indicates whether clipping has oc-
curred on output. It is a Clip-Hold Indicator. If
clipping occurs at any time, the clip light will re-
main on. To clear the Clip Indicator, click it.
Long delay times and high feedback times in-
crease the likelihood of clipping.

Mix Adjusts the ratio of dry signal to effected sig-
nal in the output. In general, this control should
be set to 100% wet, unless you are using the
Pitch plug-in in-line on an Insert for an individ-
ual track or element in a mix. This control can
be adjusted over its entire range with little or no
change in output level.

Delay Sets the delay time between the original
signal and the pitch-shifted signal. It has a max-
imum setting of 125 milliseconds. You can use
the Delay control in conjunction with the Feed-
back control to generate a single pitch-shifted
echo, or a series of echoes that climb in pitch.

Feedback Controls the amount and type of feed-
back (positive or negative) applied from the out-
put of the delay portion of the Pitch plug-in
back into its input. It also controls the number
of repetitions of the delayed signal. You can use
it to produce effects that spiral up or down in
pitch, with each successive echo shifted in
pitch.

Coarse Adjusts the pitch of a signal in semitones
over a two octave range. Pitch changes are indi-
cated both in the Semitones field and in the Mu-
sical Staff Relative section below this slider. Us-
ing the —8va and +8va buttons in conjunction
with the Coarse slider provides a full 4-octave
range of adjustment.
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-8va and +8va Buttons Clicking the-8va button
adjusts pitch down one octave from the current
setting of the coarse and fine pitch controls.
Clicking the +8va button adjusts pitch up one
octave from the current setting of the coarse and
fine pitch controls.

Relative Pitch Entry (Musical Staff)

Clicking on any note on this musical staff se-
lects a relative pitch transposition value that
will be applied to an audio signal. If Middle C is
illuminated, it indicates that no pitch transposi-
tion has been selected. If a pitch transposition is
selected, the note interval corresponding to the
selected transposition value is indicated in yel-
low. Alt-clicking (Windows) or Option-clicking
(Macintosh) on the staff will set the coarse pitch
change value to zero.

T
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Relative pitch entry

Fine Controls the pitch of a signal in cents (hun-
dredths of a semitone) over a 100 cent range.
The range of this slider is —49 to +50 cents. Pre-
cise Pitch change values are indicated in the
Cents field. The flat, natural, and sharp signs be-
low this slider indicate deviation from the near-
est semitone.

Ratio Indicates the ratio of transposition be-
tween the original pitch and the selected trans-
position value.

Crossfade Adjusts crossfade length in millisec-
onds to optimize performance of the Pitch plug-
in according to the type of audio material you
are processing. The Pitch plug-in performs pitch
transposition by replicating or subtracting por-
tions of audio material and very quickly cross-
fading between these alterations in the wave-
form of the audio material.



Crossfade length affects the amount of smooth-
ing performed on audio material to prevent au-
dio artifacts such as clicks from occurring as the
audio is looped to generate the pitch shift.

In general, small, narrow-range pitch shifts re-
quire longer crossfades and large shifts require
smaller ones. The disadvantage of a long cross-
fade time is that it will smooth the signal, in-
cluding any transients. While this is sometimes
desirable for audio material such as vocals, it is
not appropriate for material with sharp tran-
sients such as drums or percussion.

The default setting for this control is Auto. At
this setting, crossfade times are set automati-
cally, according to the settings of the Coarse and
Fine pitch controls. The Auto setting is appro-
priate for most applications. However, you can
manually adjust and optimize crossfade times
using the Crossfade slider if necessary. For audio
material with sharper attack transients, use
shorter crossfade times. For audio material with
softer attack transients, use longer crossfade
times.

Minimum Pitch Sets the minimum fundamental
pitch that the Pitch plug-in will recognize when
performing pitch transposition. Use this to opti-
mize the Pitch plug-in’s performance by adjust-
ing this control based on the lowest fundamen-
tal pitch of the audio material that you want to
process.

On audio material with a low fundamental
pitch frequency content (such as an electric bass
guitar) setting this control to a lower frequency
such as 30 Hz will improve the Pitch plug-in’s
performance. The most important thing to re-
member when using this control is that the fun-
damental frequency of audio material you want
to process must be above the frequency you set
here.

The range of this slider is from 15 Hz to 1000 Hz.
The default setting is 60 Hz. Adjustment is tied
to the current setting of the Maximum Pitch
control so that the minimum range is never less
than one octave, and the maximum range never
more than five octaves.

Maximum Pitch Adjusts the maximum funda-
mental pitch that the Pitch plug-in will recog-
nize when performing pitch transposition. To
optimize the Pitch plug-in’s performance, adjust
this setting (and the Minimum Pitch setting)
based on the highest fundamental pitch of the
audio material that you want to process. The
range of this slider is from 30 Hz to 4000 Hz. The
default setting is 240 Hz.

TimeAdjuster

The TimeAdjuster plug-in provides three func-
tions:

e Compensation for delays due to TDM- or
RTAS-based routing

e Gain compensation (+/- 24 dB)

e Phase inversion for correcting out-of-phase
signals

o
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TimeAdjuster plug-in

Q For special information on Delay Compen-
" sation and Time Adjuster, see the Pro Tools
Reference Guide.
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The TimeAdjuster plug-in is an efficient way to
compensate for DSP or host-based processing
delays in your Pro Tools system.

There are three versions of the TimeAdjuster
plug-in, each of which supports different sam-
ple delay ranges:

Short Supports a maximum delay of 256 sam-
ples at all sample rates.

Medium Supports a maximum delay of 2048
samples at all sample rates.

Long Supports a maximum delay of 8192 sam-
ples at all sample rates.

TimeAdjuster Controls

Phase Invert Inverts the phase (polarity) of the
input signal. While most Digidesign plug-ins
supply a phase invert button of their own, some
third-party plug-ins may not. Phase inversion is
also useful for performing delay compensation
by tuning unknown delay factors by ear (see
“Using TimeAdjuster for Manual Delay Com-
pensation” on page 74).

Gain Provides up to 24 dB of positive or negative
gain adjustment. This control is useful for alter-
ing the gain of a signal by a large amount in real
time. For example, when you are working with
audio signals that are extremely low level, you
may want to adjust the channel gain to a rea-
sonable working range so that a fader is posi-
tioned at its optimum travel position. Use the
Gain control to make a wide range of gain ad-
justment in real time without having to perma-
nently process the audio files, as you would with
an AudioSuite plug-in.
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Delay Provides up to 8192 samples of delay com-
pensation adjustment, or general adjustment of
phase relationships of audio recorded with mul-
tiple microphones, depending on which version
of TimeAdjuster is used. It defaults to a mini-
mum delay of four samples, which is the delay
created by use of the TimeAdjuster plug-in itself.

While phase inversion controls have been used
for many years by engineers as creative tools for
adjustment of frequency response between mul-
tiple microphones, sample-level delay adjust-
ments provide far more control. Creative use of
this control can provide a powerful tool for ad-
justing frequency response and timing relation-
ships between audio signals recorded with mul-
tiple microphones.

Using TimeAdjuster for Manual
Delay Compensation

DSP and host-based processing in all digital sys-
tems incurs delay of varying amounts. You can
use the TimeAdjuster TDM plug-in to apply an
exact number of samples of delay to the signal
path of a Pro Tools track to compensate for de-
lay incurred by specific plug-ins. TimeAdjuster
provides presets for common delay-compensa-
tion scenarios.

To compensate for several plug-ins in-line, use
the delay times from each settings file as refer-
ences, and add them together to derive the total
delay time.

A Some plug-ins (such as Digidesign’s Maxim
and DINR BNR) have different delays at
different sample rates. Refer to the Digide-
sign Plug-Ins Guide for more information
about these plug-ins.



Alternatively, look up the delay in samples for
the plug-ins you want to compensate for, then
apply the appropriate amount of delay.

A delay table for DigiRack plug-ins appears
in Appendix B, “DSP Delays Incurred by
TDM Plug-Ins.”

To manually compensate for DSP-induced de-
lays, try one of the following methods:

Phase Inversion

If you are working with phase-coherent track
pairs, or tracks recorded with multiple micro-
phones, you can invert the phase to negate the
delay. If you don’t hear any audio when you in-
vert a signal’s phase, you have precisely adjusted
and compensated for the delay. This is because
when you monitor duplicate signals and invert
the polarity (phase) of one of them, the signals
will be of opposite polarity and cancel each
other out. This technique is convenient for find-
ing the exact delay setting for any plug-in.

To determine the delay of a plug-in by inverting its
signal phase:

1 Place duplicate audio regions on two different
audio tracks and pan them to the center
(mono).

2 Apply the plug-in whose delay you want to
calculate to the first track, and a Time Adjuster
plug-in to the second track.

3 With TimeAdjuster, invert the phase.

4 Control-drag (Windows) or Command-drag
(Macintosh) to fine-tune delay in one sample in-
crements, or use the up/down arrow keys to
change the delay one sample at a time until the
audio signal disappears.

5 Change the polarity back to normal.

6 Save the TimeAdjuster setting for later use.

Comb-Filter Effect Cancellation

Adjust the delay with the signal in phase until
any comb-filter effects cancel out.

Viewing Channel Delay

Because plug-ins display their delay values in
the channel delay indicators, this can be used as
another method for determining delay compen-
sation.

To view time delay values and use TimeAdjuster to
compensate for the delay:

1 Control-click (Windows) or Command-click
(Macintosh) the Track Level Indicator to toggle
between level (that appears on the display as
“vol”), headroom (“pk”), and channel delay
(“dly”) indications. Delay values are shown in
samples.

£
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Determining the DSP delay of track inserts (Mix window
shown)

2 Apply the TimeAdjuster plug-in to the track
whose delay you want to increase, and Control-
click (Windows) or Command-click (Macin-
tosh) its Track Level indicator until the channel
delay value is displayed for that track.

3 Change the delay time in TimeAdjuster by
moving the Delay slider or entering a value in
the Delay field, until the channel delay value
matches that of the first track.

4 Test the delay values by duplicating an audio
track and reversing its phase while compensat-
ing for delay.
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When to Compensate for Delays

If you want to compensate for delays across your
entire system with Time Adjuster, you will want
to calculate the maximum delay incurred on
any channel, and apply the delays necessary to
each channel to match this channel.

However, this may not always be necessary. You
may only really need to compensate for delays
between tracks where phase coherency must be
maintained (as with instruments recorded with
multiple microphones or stereo pairs). If you are
working with mono signals, and the accumu-
lated delays are small (just a few samples, for ex-
ample), you probably needn’t worry about delay
compensation.

For more information about delays and
mixing with Pro Tools HD, see the
Pro Tools Reference Guide.

Trim

The Trim plug-in can be used to attenuate an au-
dio signal from —c (Infinity) dB to +6 dB or —c
(Infinity) dB to +12 dB. For example, using a
multi-mono Trim plug-in on a multi-channel
track provides simple, DSP-efficient muting
control over the individual channels of the
track. This capability is useful, since Track Mute
buttons mute all channels of a multi-channel
track and do not allow muting of individual
channels within the track.
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Q Alt-click (Windows) or Option-click (Mac-
" intosh) the Trim selector to open a Plug-In
window for each channel of a multi-chan-

nel track.

Trim Controls

Phase Invert Inverts the phase (polarity) of the
input signal to change the frequency response
characteristics between multi-miked sources or
to correct for miswired microphone cables.

Gain Provides —o dB to +6 dB or +12 dB of gain
adjustment, depending whether the Gain toggle
is set to +6 or +12.

+6/+12 Gain toggle Switches the maximum
level of attenuation between —e dB to +6 dB and
—oo dB to +12 dB.

A Automation data adjusts to reflect the cur-
rent Gain setting. When working with au-
tomation data from an older version of the
Trim plug-in, ensure the Gain setting is set
at +6 dB.

Output Meter Indicates the output level, includ-
ing any gain compensation added using the
Gain control.

Mute Mutes the signal output.

See also “Linking and Unlinking Controls
on Multi-Mono Plug-ins” on page 19.



chapter 6

DigiRack AudioSuite Plug-Iins

EQ I

The EQ III Plug-In provides a high-quality
7 Band, 2-4 Band, or 1 Band EQ for adjusting
the frequency spectrum of audio material.

The EQ III Plug-In appears as two separate
choices in the plug-in the AudioSuite menu:

7 Band, or 1 Band. (2-4 Band is not available in
AudioSuite format; use the 7 Band instead).

7 Band EQ and 2-4 Band EQ

The 7 Band EQ and the 2-4 Band EQ have the
same window and identical controls, but on the
2-4 Band EQ, a limited number of the seven
available bands can be active at the same time.

| eiainac
7 Band EQ and 2-4 Band EQ window

1 Band EQ

The 1 Band EQ has its own window, with six se-
lectable filter types.

1 Band EQ window

The features of these plug-ins are non-real-time,
but otherwise identical to their real-time coun-
terparts.

For information on the individual controls
for these plug-ins, see “EQ 111" on page 41

EQI

For information, see the electronic PDF guide
for the EQ II plug-ins.

Chapter 6: DigiRack AudioSuite Plug-Ins 77



.
Dynamics Il ®

There are five different AudioSuite dynamics
plug-ins. They include:

e Compressor II

e Limiter II Input .
° cuell S —————
e Expander/Gate II : —

o DeEsser Gam  L_oomf T

Threshold[ zzoes] ——— & ———
The features of these plug-ins are non-real-time,
but otherwise identical to their real-time coun-
terparts.

For information on the individual controls
for these plug-ins, see “Dynamics I1” on
page 61.

LIMIFERSIT

D IGIRACH GATE T
Y IGIRACH GOMPRESEIRA

Gate Il AudioSuite plug-in
Compressor Il AudioSuite plug-in
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DeEsser AudioSuite plug-in

LYPANDER/GATE 1T

Chorus

Chorus adds a shimmering quality to audio ma-
terial by combining a time-delayed, pitch-
shifted copy of an audio signal with itself.

Q The Chorus plug-in was formerly called
D-fx Chorus. It is fully compatible with all
settings and presets created for D-fx Chorus.

Chorus plug-in

Gain Adjusts the input volume of the chorus to
prevent clipping or increase the level of the pro-
cessed signal. This slider is set to a default of

+3 dB. If your source audio has been recorded
very close to peak level, this +3 dB default set-
ting could cause clipping. Use this control to re-
duce the input level.

Selecting the Sum Input button sums the dry in-
put signals (mono or stereo) before processing
them. The dry signal then appears in the center
of the stereo field and the wet, effected signal
will be output in stereo.

When the Sum Inputs button is selected, the
LFO waveform on the right channel is automat-
ically phase inverted to enhance the mono-ste-
reo effect.

Sum Inputs button
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Mix Adjusts the balance between the effected
signal and the original signal and controls the
depth of the effect. Mix is adjustable from 0% to
100%.

Low-Pass Filter Controls the cutoff frequency of
the Low-Pass Filter. Use this to attenuate the
high frequency content of the feedback signal.
The lower the setting, the more high frequen-
cies are removed from the feedback signal.

The range of the Low-Pass Filter is 20 Hz to
19.86 kHz, with a maximum value of Off (which
effectively means bypass).

Delay Sets the delay time between the original
signal and the chorused signal. The higher the
setting, the longer the delay and the wider the
chorusing effect. Delay is adjustable from 0-20
milliseconds.

LFO Rate Adjusts the rate of the LFO (low fre-
quency oscillator) applied to the delayed signal
as modulation. The higher the setting, the more
rapid the modulation. You can select either a
sine wave or a triangle wave as a modulation
source, using the LFO Waveform selector.

LFO Width Adjusts the intensity of the LFO ap-
plied to the delayed signal as modulation. The
higher the setting, the more intense the modu-
lation. Use the LFO Waveform selector to select
a sine or a triangle wave as a modulation source.

Feedback Controls the amount of feedback ap-
plied from the output of the delayed signal back
into its input. Negative settings provide a more
intense effect.

LFO Waveform Selects a sine wave or triangle
wave for the LFO. This affects the character of
the modulation. The sine wave has a gentler
ramp and peak than the triangle wave.
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Flanger

The Flanger animates and adds a swirling, mov-
ing quality to audio material by combing a time-
delayed copy of an audio signal with itself.

The Flanger uses a through-zero flanging algo-
rithm that results in a tape-like flanging effect.
This technique delays the original dry signal by
256 samples, then modulates the delayed signal
back and forth in time in relation to the dry sig-
nal, passing through its zero point on the way.

Q The Flanger plug-in was formerly called
D-fx Flanger. 1t is fully compatible with all
settings and presets created for D-fx
Flanger.

Flanger plug-in

Gain Adjusts the input volume of the flanger to
prevent clipping or increase the level of the pro-
cessed signal. This slider is set to a default of

+3 dB. If your source audio has been recorded
very close to peak level, this +3 dB default set-
ting could cause clipping. Use this control to re-
duce the input level.

Selecting the Sum Input button sums the dry in-
put signals (mono and stereo) before processing
them. The dry signal then appears in the center
of the stereo field and the wet, effected signal
will be output in stereo.



When the Sum Inputs button is selected, the
LFO waveform on the right channel is phase in-
verted to enhance the mono-stereo effect.

Mix Adjusts the balance between the effected
signal and the original signal and controls the
depth of the effect. Mix is adjustable from 0% to
100%.

High-Pass Filter Controls the cutoff frequency of
the High-Pass Filter. Use this to attenuate the
frequency content of the feedback signal and
the frequency response of the flanging. The
higher the setting, the more low frequencies are
removed from the feedback signal.

LFO Rate Adjusts the rate of the LFO (low fre-
quency oscillator) applied to the delayed signal
as modulation. The higher the setting, the more
rapid the modulation. You can select either a
sine wave or a triangle wave as a modulation
source, using the LFO Waveform selector.

LFO Width Adjusts the intensity of the LFO ap-

plied to the delayed signal as modulation. The

higher the setting, the more intense the modu-
lation.

Feedback Controls the amount of feedback ap-
plied from the output of the delayed signal back
into its input. Negative settings provide a more
intense effect.

LFO Waveform Selects a sine wave or triangle
wave for the LFO. This affects the character of
the modulation. The sine wave has a gentler
ramp and peak than the triangle wave.

Multi-Tap Delay

The Multi-Tap Delay adds up to four indepen-
dently-controllable delays or taps to the original
audio signal. Use the Multi-tap delay to add spa-
tialization or complex rhythmic echo effects to
audio material. You can individually control the
delay time and number of repetitions of each of
the four taps.

Q The Multi-Tap Delay plug-in was formerly
"~ called D-fx Multi-Tap Delay. It is fully
compatible with all settings and presets cre-
ated for D-fx Multi-Tap Delay.

Ihlti-Tap Delay playlist use in playlist
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Multi-Tap Delay plug-in

Gain The Gain slider for each of the Multi-Tap
delay’s four delay lines controls the input level
of that individual delay tap. Adjust Gain to pre-
vent clipping or increase the level of the pro-
cessed signal.
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Selecting the Sum Input button sums the dry in-
put signals (mono or stereo) before processing
them. The dry signal then appears in the center
of the stereo field and the wet, effected signal
will be output in stereo.

Feedback Controls the amount of feedback ap-
plied from the output of the delay into its input.
It also controls the number of repetitions of the
delayed signal. For the feedback feature to func-
tion, the Gain slider must be raised above its
lowest setting.

Pan The pan sliders for each of the four taps con-
trol their apparent location in the stereo field.

Delay Sets the delay time between the original
signal and the delayed signal. The higher the
setting, the longer the delay. This control is ad-
justable from 0-1500 milliseconds (1.5 sec-
onds).

Mix Adjusts the balance between the effected
signal and the original signal and controls the
depth of the effect. Mix is adjustable from 0% to
100%.

Selecting Audio for Processing with
AudioSuite Delay

Because Multi-Tap Delay adds additional mate-
rial to the end of selected audio (a delay tap),
make a selection that is longer than the original
source material so AudioSuite Delay can write it
into the audio file.

Select only the original material, without leav-

ing additional space at the end, will produce a

delay that occurs after the end of the region will
be cut off.
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To accommodate for this, place the region in a
track, and select the desired audio plus an
amount of blank space at the end of the region
equal to the amount of delay that you have
added in the plug-in. The plug-in will then have
space at the end of the region in which to write
the final delay.

Ping-Pong Delay

The Ping-Pong Delay plug-in adds a controllable
delay to the original audio signal. Use the Ping-
Pong delay to add spatialization, and panned
echo to audio material. This plug-in feeds back
delayed signals to their opposite channels, cre-
ating a characteristic ping-pong echo effect.

Q The Ping-Pong Delay plug-in was formerly
" called D-fx Ping-Pong Delay. It is fully
compatible with all settings and presets cre-
ated for D-fx Ping-Pong Delay.

Ping-Pong Delay plug-in

Gain Adjusts the input volume of the Ping-Pong
Delay to prevent clipping or increase the level of
the processed signal.

Mix Adjusts the balance between the effected
signal and the original signal and controls the
depth of the effect. Mix is adjustable from 0% to
100%.



Delay Sets the delay time between the original
signal and the delayed signal. The higher the
setting, the longer the delay. This control is ad-
justable from 0-1500 milliseconds (1.5 sec-
onds).

Low-Pass Filter Controls the cutoff frequency of
the Low-Pass Filter. Use this to attenuate the
high frequency content of the feedback signal.
The lower the setting, the more high frequen-
cies are removed from the feedback signal.

The range of the Low-Pass Filter is 20 Hz to
19.86 kHz, with a maximum value of Off (which
effectively means bypass).

Feedback Controls the amount of feedback ap-
plied from the output of the delay into its input.
It also controls the number of repetitions of the
delayed signal.

Cross-Feedback Cross-Feedback feeds the de-
layed signals to their opposite channel: The left
channel delay is fed to the right channel input
and vice-versa. The result is a stereo echo that
ping-pongs back and forth between the right
and left channels.

Selecting Audio for Delay Processing

Because Ping-Pong Delay adds additional mate-
rial (a delay tap) to the end of selected audio,
make a selection that is longer than the original
source material to allow the delay tap to be writ-
ten into the end of the audio file.

Selecting only the original material, without
leaving additional space at the end, will cause
delay taps that occur after the end of the region
to be cut off.

Invert

The Invert plug-in reverses the polarity of se-
lected audio. Positive sample amplitude values
are made negative, and all negative amplitudes
are made positive.

This process is useful for altering the phase or
polarity relationship of tracks. The Invert plug-in
is useful during mixing for modifying frequency
response between source tracks recorded with
multiple microphones. You can also use it to
correct audio recorded out of phase with an in-
correctly wired cable.

®
payie e n iy

Invert plug-in
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Duplicate

The Duplicate plug-in duplicates the selected
audio in place. Depending on how its controls
are configured, the new region will appear in ei-
ther the Regions List or playlist. You can use this
to flatten or consolidate an entire track consist-
ing of multiple regions into one continuous au-
dio file that resides in the same place as the orig-
inal individual regions.

23]
playlist usz in playlist
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Duplicate plug-in

The audio is unaffected by Pro Tools volume or
pan automation, or by any real-time plug-ins
that may be in use on the track as inserts. The
original audio file regions are merely rewritten
in place to a single duplicate file.

The Duplicate plug-in works nondestructively.
You cannot choose to overwrite files.
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Delay

The Delay plug-in provides time delay-based ef-
fects, with up to 10.9 seconds of delay, at any
session sample rate. You can also use it to pro-
duce multiple delay-based effects, including slap
echo, doubling, chorusing, and flanging.
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Delay AudioSuite plug-in

The controls of the AudioSuite Delay plug-in op-
erate in non-real-time, but are otherwise identi-
cal to the real-time Mod Delay II plug-in.

For information on the individual controls
for the AudioSuite Delay plug-in, see “Mod
Delay II” on page 68.

If you have the Mod Delay Plug-In installed,
Short Delay, Slap Delay, Medium Delay, and
Long Delay will be available in the AudioSuite
menu in addition to Delay (Mod Delay II). The
features of these plug-ins are identical to their
real-time counterparts. The only difference is
that the AudioSuite versions operate in non-real
time.

For information on the individual controls
for the AudioSuite Short Delay, Slap Delay,
Medium Delay, and Long Delay plug-ins,
see “Mod Delay I11” on page 68.



Selecting Audio Delay Processing

Because AudioSuite Delay adds additional mate-
rial (a delay tap) to the end of selected audio,
make a selection that is longer than the original
source material to allow the delay tap to be writ-
ten into the end of the audio file.

Selecting only the original material, without
leaving additional space at the end, will cause
delay taps that occur after the end of the region
to be cut off.

Normalize

The Normalize plug-in optimizes the volume
level of an audio selection. Use it on material re-
corded with too little amplitude, or on material
whose volume levels are inconsistent (as in a
poorly recorded narration).

Unlike compression and limiting, which modify
the dynamics of audio material, normalization
preserves dynamics by uniformly increasing (or
decreasing) amplitude.

Q To prevent clipping during sample rate con-
" version, Normalize to no greater than the
range between —2 dB to 0.5 dB. Optimum
settings will vary with your program mate-
rial and your Conversion Quality setting (in
the Editing tab of the Preferences dialog).

Normalize playlist

use in playlist

create continuous file entire selection LewvelOnAlChans / Tracks,

el S I i
[DIGIRACK | NORMALIZE

process

Normalize plug-in

Max Peak At Specifies how close to maximum
level (clipping threshold) the peak level of a se-
lection is boosted. Set this value by adjusting the
Max Peak At slider, by entering a numeric deci-
bel value below the clipping threshold, or by en-
tering a percentage of the clipping threshold.

You can normalize stereo pairs together so that
two sides of a stereo signal are processed relative
to each other.

RMS/Peak Toggle Switches the calibration of
normalizing between Peak or RMS modes. Peak
normalizes the input signal at the maximum
possible level without clipping. RMS normalizes
the input signal at a level consistent with the
RMS (Root-Mean-Square) value, or the effective
average level of the selected region.

Normalizing Multiple Regions Across Tracks

When multiple regions are selected across mul-
tiple tracks, the Normalize plug-in can search
for peaks in two different modes:

Peak On Each Chan/Track Searches for the peak
level on a channel-by-channel or track-by-track
basis.

Peak On All Chans/Tracks Searches for the peak
level of the entire selection. If ten tracks are se-
lected, for example, the Normalize function will
find the peak value from all ten.
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The Gain plug-in boosts or lowers a selected re-
gion’s amplitude by a specific amount. Use it to
smooth out undesired peaks and other dynamic
inconsistencies in audio material.

create continuous file
Gan KRR T oy

LEVEL RESULT
| DIGIRACK | GAIN

Gain plug-in

Gain Specifies the desired gain level. Set this
value by manually adjusting the Gain slider, or
by entering a numeric decibel value, or by enter-
ing a percentage.

Find Level When clicked, displays the peak am-
plitude value of the current selection.

RMS /Peak Toggle Switches the calibration of
gain adjustment between Peak or RMS modes.
Peak adjusts the gain of the input signal to the
maximum possible level without clipping. RMS
adjusts the input signal to a level consistent
with the RMS (Root-Mean-Square) value, or the
effective average level of the selected region.

Reverse

The Reverse plug-in replaces the audio with a re-
versed version of the selection.

®

Reverse plug-in

86 DigiRack Plug-Ins Guide

Signal Generator

The Signal Generator plug-in produces audio
test tones in a variety of frequencies, waveforms,
and amplitudes.

Signal Generator playlist use in playlist
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Signal Generator plug-in

The features of this plug-in are non-real-time,
but otherwise identical to its real-time counter-
part.

Q You can use the AudioSuite Signal Genera-
" tor plug-in for musical purposes as well as
for testing purposes. For example, you might
want to add a little color to a kick drum
track by doubling it with a 50 Hz tone, us-
ing the Kick track as the key input signal
gating the tone track.

To create an audio region using the Signal
Generator plug-in:

1 Make a selection in the Tracks window.
2 Choose AudioSuite > Signal Generator.

3 Enter values for the Frequency, Level, and Sig-
nal controls.



4 Click Process in the Signal Generator plug-in.

Q Select the Create Continuous File option for
" greater flexibility in making audio selec-
tions for use with the Signal Generator plug-
in.

For information on the individual controls
for the Signal Generator plug-in, see “Signal
Generator” on page 70.

DC Offset Removal

The DC Offset Removal plug-in removes DC off-
set from audio files. DC offset is a type of audio
artifact (typically caused by miscalibrated ana-
log-to-digital convertors) that can cause pops
and clicks in edited material.

To check for DC offset, find a silent section in
the audio material. If DC offset is present, a
near-vertical fade-in with a constant or steady-
state offset from zero will appear in the wave-
form. Use the DC Offset Removal plug-in to re-
move it.

23]
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DC Offset Removal plug-in

Time Compression/
Expansion

The Time Compression/Expansion plug-in ad-
justs the duration of selected regions, increasing
or decreasing their length without changing
pitch.
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Time Compression/Expansion plug-in

It is especially useful in audio post-production
for adjusting audio to specific time or SMPTE
durations for synchronization purposes. Time
Compression/Expansion is nondestructive.

Q Normalizing a selection before using Time
© Compressing/Expansion may produce better
results.

Source and Destination The Source fields display
the length of the current selection before pro-
cessing in each of the listed formats. All fields
are always active; a change made to one value is
immediately reflected in the others.

The Destination fields both display and control
the final length of the selection after processing.
Enter the length of the Destination file by dou-
ble-clicking the appropriate field in the Destina-
tion column.
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Use the Ratio, Crossfade, Min Pitch, and Accu-
racy controls to fine-tune the Time Compres-
sion/Expansion process.

Ratio Sets the destination length in relation to
the source length. Moving the slider to the right
increases the length of the destination file,
while moving the slider to the left decreases its
length.

Crossfade Adjusts the crossfade length in milli-
seconds, optimizing performance of the Time
Compression/Expansion according to the type
of audio material being processed. (This plug-in
achieves length modification by replicating or
subtracting very small portions of audio mate-
rial and very quickly crossfading between these
alterations in the waveform of the audio mate-
rial.)

Crossfade length affects the amount of smooth-
ing performed on audio material. This prevents
audio artifacts such as clicks from occurring.

Long crossfade times may over-smooth a signal
and its transients. This may not be desirable on
drums and other material with sharp transients.

Use the Crossfade slider to manually adjust and
optimize crossfade times if necessary. For audio
material with sharper attack transients, use
smaller crossfade times. For audio material with
softer attack transients, use longer crossfade
times.
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Min Pitch Sets the minimum, or lowest, pitch
that will be used in the plug-in’s calculations
during the Time Compression/Expansion pro-
cess. The control has a range of 40 Hz to 1000
Hz.

This control should be set lower when process-
ing bass guitar or audio material with a low fre-
quency range. Set this control higher when pro-
cessing higher frequency range audio material.

Accuracy Prioritizes the processing resources al-
located to audio quality (Sound) or timing
(Rhythm). Moving the slider towards “Sound”
generally results in better sonic quality and
fewer audio artifacts. Moving the slider towards
“Rhythm” puts the emphasis on keeping the
tempo consistent.

When you are working with audio loops, listen
carefully and adjust the Accuracy slider until
you find a setting that keeps timing solid within
the region. If you don't, start and end times may
be precise, but the beats in rhythmic material
may appear to be shuffled if too little priority is
given to Rhythm.

A\ Time Compression & Expansion settings
created in version 4.x and later of Pro Tools
for Windows are not compatible with later
versions.



Pitch Shift

The Pitch Shift plug-in adjusts the pitch of any
source audio file with or without a change in its
duration. This is a very powerful function that
transposes audio a full octave up or down in
pitch with or without altering playback speed.

5]

Pitzh Shift playlist use in playlist
Gy serm ] |+ @) compars

GAIN

COARSE

FINE

RATIO o]
crossrape [EEN 1
unercH  [EEEH ]
accuracy [N

RHYTHM

SOUND

TIME CORRECTION 154
Reference pitch

PIICH SHIFT

Pitch Shift plug-in

Gain Adjusts input level, in 10ths of a dB. Drag-
ging the slider to the right increases gain, drag-
ging to the left decreases gain.

Coarse and Fine Adjusts amount of pitch shift.
The Coarse slider transposes in semitones (half
steps). The Fine slider transposes in cents (hun-
dredths of a semitone).

Time Correction Disabling this option has the ef-
fect of “permanently varispeeding” your audio
file. The file’s duration will be compressed or ex-
tended according to the settings of the Coarse
and Fine pitch controls. When Time Correction

is enabled, fidelity can be affected. For example,
time expansion as a result of Time Correction
when lowering pitch can cause the audio to
sound granulated.

Ratio Adjusts the amount of transposition
(pitch change). Moving the slider to the right
raises the pitch of the processed file, while mov-
ing the slider to the left decreases its pitch.

Crossfade Use this to manually adjust crossfade
length in milliseconds to optimize performance
of the Pitch Shift plug-in according to the type
of audio material you are processing. This plug-
in achieves pitch transposition by processing
very small portions of the selected audio mate-
rial and very quickly crossfading between these
alterations in the waveform of the audio mate-
rial.

Crossfade length affects the amount of smooth-
ing performed on audio material. This prevents
audio artifacts such as clicks from occurring. In
general, smaller pitch transpositions require
longer crossfades; wider pitch transpositions re-
quire smaller crossfades. Long crossfade times
may over-smooth a signal and its transients.
This is may not be desirable on drums and other
material with sharp transients.

Use the Crossfade slider to adjust and optimize
crossfade times. For audio material with sharper
attack transients, use smaller crossfade times.
For audio material with softer attack transients,
use longer crossfade times.

Min Pitch Sets the lowest pitch used in the plug-
in’s Pitch Shift processing. The control has a
range of 40 Hz to 1000 Hz. Use it to focus the
Pitch Shift process according to the audio’s spec-
tral shape.

Use lower values when processing lower fre-
quency audio material. Use higher values when
processing higher frequency audio material.

Chapter 6: DigiRack AudioSuite Plug-Ins

89



Accuracy Sets the processing resources allocated
to audio quality (Sound) or timing (Rhythm).
Set the slider toward Sound for better audio
quality and fewer audio artifacts. Set the slider
toward Rhythm for a more consistent tempo.

Reference Pitch Activates a sine wave-based
pitch generator that you can use as an audible
reference when pitch-shifting audio material.

Note Adjusts the frequency of the reference tone
in semitones (half steps).

Detune Provides finer adjustment of the fre-
quency of the reference tone in cents (100ths of
a semitone).

Gain Adjusts the volume of the reference tone
in dB.

To use the Reference Pitch:

1 Select the audio material you want to use as a
pitch reference. Click the preview button to be-
gin playback of the selected audio.

2 Click the Reference Pitch button to activate
the reference sine wave tone.

3 Adjust the Note and Detune settings to match
the reference tone to the pitch of the audio play-
back. Adjust the Gain setting to change the rel-
ative volume of the reference tone. It may also

be helpful to toggle the Reference Pitch on and
off to compare pitch.

4 Select the audio material to be pitch shifted.

5 Adjust the Coarse and Fine Pitch Shift con-
trols to match the pitch of the audio playback to
the reference pitch.

6 Click Process to apply pitch shift to the selec-
tion.
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Using Digi ReWire

Pro Tools supports ReWire version 2.0 technol-
ogy developed by Propellerheads Software. Re-
Wire is available as a DigiRack RTAS plug-in.

ReWire provides real-time audio and MIDI
streaming between applications, with sample-
accurate synchronization and common trans-
port functionality.
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ReWire RTAS plug-in

Using ReWire, Pro Tools can send MIDI to a Re-
Wire client application, such as software synthe-
sizer and receive audio back from the ReWire cli-
ent.

A\ Pro Tools does not support receiving MIDI
from ReWire client applications.

Compatible ReWire client applications are auto-
matically detected by Pro Tools and are avail-
able in the RTAS Plug-Ins Insert menus in

Pro Tools. Selecting a ReWire client application
within Pro Tools will automatically launch that
application (if the client application supports
this feature). Any corresponding MIDI nodes for
that application will be available in the MIDI
Track Output selector.

Once the outputs of your software synthesizers
and samplers are routed to Pro Tools, you can:
e Process incoming audio signals with plug-
ins
e Automate volume, pan, and plug-in con-
trols
e Bounce To Disk
e Take advantage of the audio outputs of
your Digidesign audio interfaces

A Exchange of additional metadata such as
controller and note names between
Pro Tools and ReWire clients is not sup-
ported.

Chapter 7: Using Digi ReWire
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ReWire Requirements

To use the ReWire plug-in, you will need:

¢ A Digidesign-qualified Windows or Macin-
tosh computer running Pro Tools HD or
Pro Tools LE software version 7.0 or higher

e ReWire-compatible client software, such as:
e Reason from Propellerheads Software
e Live from Ableton

A\ Client software must support the same
sample rate as the session using ReWire.
For example, third-party client software
that does not support sample rates beyond
48 kHz cannot be used in 96 kHz Pro Tools
sessions.

ReWire support is also under development for
other third-party companies. For availability,
check with the manufacturer or the Digidesign
Web site (www.digidesign.com).

ReWire and Track Count with
Pro Tools HD

With Pro Tools HD, the ReWire RTAS plug-in
can be inserted on any kind of track. Each chan-
nel of audio transmitted through ReWire then
uses the same amount of resources as the audio
track on which it is inserted.

Consequently, you can only use a total combi-
nation of audio tracks and ReWire audio streams
that does not exceed the maximum number of
possible voices for your system. For example, if
you are playing 40 audio tracks in a 48 kHz/24-
bit session on a 128-voice Pro Tools|HD 2 core
system, that will leave 88 channels of audio (88
mono, or 44 stereo) that can be used with Re-
Wire. (ReWire supports a maximum of 64 audio
streams per application.)
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Using ReWire at higher sample rates will in-
crease the load on the CPU. For example, CPU
load at 96 kHz is double the load at 48 kHz. You
can monitor Pro Tools CPU usage in the System
Usage window, making sure to not overtax your
system.

Q With Pro Tools HD, the standard Hardware
Buffer size of 512 samples is strongly rec-
ommended for using ReWire in sessions
with sample rates above 48 kHz.

ReWire and Track Count on
Pro Tools LE Systems

With Pro Tools LE, performance is determined
by several factors, including host CPU speed,
available memory, and buffer settings. Digi-
design cannot guarantee 64 simultaneous audio
channel outputs with ReWire on all computer
configurations.

For the latest information on recommended
CPUs and system configurations, check the
Digidesign Web site (www.digidesign.com/com-
pato).



Using ReWire

The ReWire plug-in is installed when you install
Pro Tools. All inter-application communica-
tions between Pro Tools and ReWire client soft-
ware is handled automatically.

To use a ReWire client application with Pro Tools:

1 Make sure that the ReWire client application
is installed properly and that you have restarted
your computer.

2 In Pro Tools, choose Track > New and specify
one Instrument track (or audio or Auxiliary In-
put track), and click Create.

3 In the Mix window, click the Insert selector on
the track and assign the ReWire RTAS client
plug-in to the track insert.

The ReWire client application will launch auto-
matically in the background (if the client appli-
cations supports auto-launch). If the client ap-
plication does not support auto-launch, launch
it manually.

4 Configure the ReWire client application to
play the sounds you want.

5 In Pro Tools, set the output of the client appli-
cation in the ReWire plug-in window.

A\ Some ReWire client applications, such as
Reason, support a single stereo output path
(Reason’s remaining 62 outputs are mono
only). If you want to use multiple stereo
outputs with Reason you will need to insert
multiple multi-mono ReWire plug-ins, then
unlink and assign left and right outputs
separately using the Link Enable and Chan-
nel selector buttons in the Plug-In window.

6 In the Mix window, click the track’s MIDI Out-
put selector a and select the ReWire client appli-
cation. Some ReWire clients (such as Reason)
may list multiple devices. If so, choose the de-
vice that you want.

7 Choose Options > MIDI Thru and record en-
able the MIDI track. Play some notes on your
MIDI controller to trigger the client application.

8 If your ReWire client application is a se-
quencer and you want to begin synchronized
playback with Pro Tools, press the Spacebar or
click the Play button on the Pro Tools Transport.

A\ I you experience system performance prob-
lems while using Pro Tools with ReWire cli-
ent applications, you may need to increase
the Pro Tools CPU Usage Limit. See “CPU
Usage Limit” on page 9 for instructions.

Quitting ReWire Client Applications

When quitting Pro Tools sessions that integrate
ReWire client applications, quit the client appli-
cation first, then quit Pro Tools.

A\ Ifyou quit Pro Tools before quitting ReWire
client applications, a warning dialog box
may appear stating that “one or more Re-
Wire applications did not terminate.” To
avoid this, quit all ReWire client applica-
tions before quitting Pro Tools.

Chapter 7: Using Digi ReWire
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Tempo and Meter Changes

Pro Tools transmits both Tempo and Meter data
to ReWire client applications, allowing ReWire-
compatible sequencers to follow any tempo and
meter changes in a Pro Tools session.

With the Pro Tools Conductor button selected,
Pro Tools always acts as the Tempo master, us-
ing the tempo map defined in its Tempo Ruler.

With the Pro Tools Conductor button dese-
lected, the ReWire client acts as the Tempo mas-
ter. In both cases, playback can be started or
stopped in either application.

A Pro Tools supports tempo values from
30-300 bpm. When slaved to a ReWire cli-
ent application, Pro Tools playback will be
restricted to this range even if the client ap-
plication’s tempo is outside this range. Ad-
ditionally, some ReWire client applications
(such as Reason) may misinterpret
Pro Tools meter changes, resulting in mis-
matched locate points and other unexpected
behavior. To prevent this, avoid using meter
changes in Pro Tools when using Reason as
a ReWire client.

Looping Playback

Because Pro Tools does not offer separate loop
markers as found in other third party applica-

tions such as Reason, if you want to loop play-
back, do one of the following:

To loop playback in Pro Tools:

1 In the Pro Tools Time Line, select the time
range that you want to loop.

2 Begin playback by pressing the Spacebar or
clicking the Transport’s Play button.
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To loop playback within a ReWire client sequencer

= With playback stopped, specify the loop
within the ReWire client application and begin
playback.

A\ If you create a playback loop by making a
selection in the Pro Tools Time Line, once
playback is started, any changes made to
loop or playback markers within the Re-
Wire client application will deselect the
Pro Tools Time Line selection and remove
the loop.

Automating ReWire

ReWire supports automation for switching in-
puts during playback.

To automate switching inputs during playback:

1 Set the track’s automation to write.

2 Change the input link pop-up menu manu-
ally.

Draw the automation in the Edit window.

For more information on drawing automa-
tion, see the Pro Tools Reference Guide.



DSP Requirements for TDM Plug-Iins

The number of TDM plug-ins you can use at one
time depends on how much DSP power is avail-
able in your system. Since the TDM hardware on
Pro Tools cards provide dedicated DSP for plug-
ins, plug-in performance is not limited by CPU
processing power.

The DSP tables on the following pages show the
theoretical total number of instances of each
DigiRack TDM plug-in that can be powered by a
single DSP chip on Pro Tools|HD-series cards.
DSP usage differs according to card type and
DSP chip availability.

A\ DSP tables show the theoretical maximum
performance when no other plug-ins or sys-
tem tasks (such as I/O) are sharing avail-
able DSP resources. You will typically use
more than one type of plug-in simulta-
neously. The data in these tables are pro-
vided as guidelines to help you gauge the
relative efficiency of different plug-ins on
your system. They are not guaranteed per-
formance counts that you should expect to
see in typical real-world sessions and usage.

There are a total of nine DSP chips on a

Pro Tools|HD card (HD Core, HD Process, and
HD Accel). HD Core and HD Process cards pro-
vide identical chip sets. HD Accel cards provide
newer, more powerful DSP chips (making the
HD Accel card ideal for DSP-intensive plug-ins,
and for high sample rate sessions).

Not all plug-ins are supported on all types of
chips. The following tables indicate the number
of compatible chips per card.

DSP Requirements

DSP requirements for DigiRack TDM plug-ins
are provided on the following pages.

Appendix A: DSP Requirements for TDM Plug-Ins
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Mono and Stereo DigiRack Plug-Iins on HD Cards

The following table compares the maximum number of instances of each DigiRack TDM plug-in that
can be powered by a single DSP chip on an HD Accel card to that of HD Core and HD Process cards.

Maximum instances of real-time TDM plug-ins per DSP chip for Pro Tools |HD cards at 44.1 and 48 kHz

Plugn HD Accel HD Core and HD Process
mono/stereo mono/stereo

EQ Il (1-band) 66 33 28 14
EQ Il (2-4 band) 36 18 15 7
EQ Il (7-band) 23 11 10 5
Compressor I 30 20 26 17
Click 18 n/a 3 n/a
De-esser 46 n/a 20 n/a
Dither 46 43 34 18
D-Verb 6 6 4 4
Limiter Il 60 40 16 17
Gate Il 106 51 59 20
Expander/Gate Il 54 46 24 20
Mod Delay Il (short) 74 36 43 21
Mod Delay Il (slap) 73 36 32 16
Mod Delay Il (medium) 36 18 16 8
Mod Delay Il (long) 17 7 8 4
Mod Delay Il (extra long) 4 2 2 1
Pitch 1 1 1 1
POW-r Dither 22 10 9 4
Time Adjuster (short) 146 72 117 58
Time Adjuster (medium) 32 16 114 56
Time Adjuster (long) 72 36 32 16
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Maximum instances of real-time TDM plug-ins per DSP chip for Pro Tools |HD cards at 44.1 and 48 kHz

HD Accel HD Core and HD Process
Plug-In
mono/stereo mono/stereo
Trim 145 n/a 119 n/a
Signal Generator 48 n/a 25 n/a

Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at
176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

Multi-Mono and Multi-Channel DigiRack Plug-Ins

Plug-ins used in multi-mono format on greater-than-stereo tracks require one mono instance per
channel of the multi-channel audio format. A multi-mono EQ used on a 5.1 format track, for exam-
ple, requires six mono instances since there are six audio channels in the 5.1 format. Because multi-
channel versions of the Compressor II, Limiter I, and Expander/Gate II plug-ins are available for use
on greater-than-stereo tracks, separate instance counts are given for those configurations.

Table 2. Theoretical maximum instances of real-time TDM plug-ins per DSP chip for a Pro Tools HD Core and HD
Process card at 48 kHz**

Plug-n LCR Q‘::d 5.0 5:;‘ 6'71:‘ 71 DS';;“:Z':‘ d"er
LCRS ’ ’
Compressor || 11 9 8 6 6 6 9
De-esser* 6 5 4 3 2 2 9
DigiRack Pitch partial partial partial partial partial partial 9
D-Verb partial partial partial partial partial partial 9
Limiter 1l 11 9 8 6 6 6 9
Gate Il 19 14 11 9 8 7 9
Expander/Gate I 15 13 12 11 11 10 9
Mod Delay | (short) 14 11 8 7 6 5 9
Mod Delay | (slap) 10 8 6 5 4 4 9
Mod Delay | (medium) 5 4 3 2 2 2 9
Mod Delay | (long) partial partial partial partial partial partial 9
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Table 2. (Continued) Theoretical maximum instances of real-time TDM plug-ins per DSP chip for a Pro Tools HD Core
and HD Process card at 48 kHz**

Plug-n LCR Qfd 5.0 5;:‘ 6'71:‘ 74 DS':IShciZfdpe'
LCRS ' '
Mod Delay Il (short) 14 11 8 7 6 5 9
Mod Delay Il (slap) 10 8 6 5 4 4 9
Mod Delay Il (medium) 5 4 3 2 2 2 9
Mod Delay Il (long) 2 2 1 1 1 1 9
Mod Delay Il (extra partial partial partial partial partial partial 9
long)
Dither 12 9 7 6 5 4 9
POW-r Dither 3 2 1 1 2 1 9
Time Adjuster (short) 30 22 18 15 13 11 9
Time Adjuster 30 22 18 15 13 11 9
(medium)
Time Adjuster (long) 10 8 6 5 4 4 9
Trim* 39 29 23 19 16 14 9
Signal Generator* 8 6 5 4 3 3 9

“Partial” indicates that a single instance of the multi-mono plug-in is sharing more than 1 DSP chip.

* Instance counts are provided for multi-mono versions of plug-ins that have no available multichannel ver-
sion.

** Maximum instances are approximately half at 88.2 kHz and 96 kHz, and approximately a quarter at
176.4 and 192 kHz. Actual results will likely be less due to system and session variables.

Monitoring DSP Usage

The System Usage window (Window > System Usage) shows approximately how much DSP is avail-
able in your system and how it is being used in the current Pro Tools session.

For more information about DSP usage and allocation, see the Pro Tools Reference Guide.
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appendix b

DSP Delays Incurred by TDM Plug-Ins

Virtually all TDM plug-ins incur some amount Table 3 on page 100 shows the delays inherent
of signal delay. in each type of Digidesign TDM plug-in.

If you are working with mono tracks, or are pro-
cessing all channels with the same plug-in, the
signal delays are not long enough to be signifi-
cant and should not be a concern.

This signal delay is significant only if you use a
plug-in on one channel of a stereo or multi-
channel signal but not the others, since this can
cause the channels to be slightly out of phase.

Q Pro Tools|HD systems provide automatic
Delay Compensation to compensate for sig-
nal processing delays. For detailed informa-
tion, see the Pro Tools Reference Guide.
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Table 3. Samples of delay incurred by each real-time
DigiRack TDM plug-in on HD cards

Plug-in fIaDr:zlrzss of delay on
EQ Il (1-band) 4
EQ lll (2-4 band) 4
EQ Ill (7-band) 4
Compressor I 4
De-esser 4
DigiRack Pitch 3
D-Verb 3
Limiter Il 4
Gate Il 4
Expander/Gate I 4
Mod Delay I/11 4
(short)

Mod Delay I/1l (slap) 4
Mod Delay /11 4
(medium)

Mod Delay I/1l (long) 4
Mod Delay Il (extra 4
long)

Dither 4
POW-r Dither 4
Time Adjuster 4
Signal Generator 4
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Numerics
7 Band, 2-4 Band, or 1 Band (EQ Ill) 41

A

Accuracy control 88, 90
adjusting parameters 20
Algorithm control 60
Attack control 62, 64
AudioSuite

buffer size 38

Invert 83

multichannel processing 36

plug-ins 2

processing 39

processing preferences 37
AudioSuite plug-in selector 32
AudioSuite plug-ins

Chorus 79

DC Offset Removal 87

Delay 84

Duplicate 84

Dynamics Il 78

EQII 78

Flanger 80

Gain 86

Invert 83

Multi-Tap Delay 81

Normalize 85

Ping-Pong Delay 82

Pitch Shift 89

Reverse 86

Signal Generator 86

Time Compression/Expansion 87

using 39
AudioSuite processing on networked hard drives

39

AudioSuite window 32
Audition pop-up menu 35

Auto button 17
automation

Auto Latch mode 23

Auto Touch mode 23

creating 23

plug-in 22

Safe button 17
Automation Safe button 17
Auxiliary Inputs

inserting RTAS plug-ins 29

B
bit resolution for Dither plug-in 57, 58
buffer size for AudioSuite processing 38

Bypass button 35
for real-time plug-ins 16

C
Category 12
Cents control 72
Chan/Track Process Mode 34
Channel selector 17
Chorus plug-in 79
Church algorithm 60
Click plug-in 55
Accented control 55
Unaccented control 55
Clip indicator
DigiRack Pitch 72
D-Verb 59
Clip LED 16
clipping 16
closing multiple plug-in windows 18
Coarse & Fine controls 89
Compare button 17
compensating for DSP delays 99
Compressor Il 61

Index
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configuring AudioSuite Buffer 38
Convert Plug-In pop-up 16

Copy Settings command 24

copying a plug-in setting 26

CPU meter 8

CPU power requirements for RTAS plug-ins 8
CPU Usage Limit 8

Create Continuous File command 34
Create Individual Files command 34
creating a settings subfolder 26
Crossfade control 72, 88, 89
Cross-Feedback control 83

D
DC Offset Removal plug-in 87
Decay control 61, 65, 66
DeEsser plug-in 67
Delay 12
delay
DSP induced 9, 75
Delay control 72, 80, 82
Delete Current Settings File command 24
destination fields 87
destination folder for plug-in settings 25
Diffusion control 60
Dither 12
Dither bit depth for AudioSuite 38
Dither plug-in 56, 58
pop-up menu 37
DSP
and EQ Il 52
DSP delay compensation 10, 74, 76
DSP delays 99
DSP delays inherent in plug-ins 99
Duplicate plug-in 84
duplicating inserts 14
D-Verb 59
Dynamics 12
Dynamics Il plug-ins 61
Compressor |l 61
DeEsser 67
Expander/Gate |l 66
Gate Il 65
Limiter Il 63
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E
Edit Settings option 38
Effects 12
effects
recording with 11
Entire Selection mode 34
EQ 12
EQ Il 41
EQ Il plug-ins 55, 77
EQ Il 41
DSP management 52
Frequency Graph Display 43
gain (inverting) 42
Expander/Gate Il 66
external audio source, using for side-chain 21
External Key 21
External Key control 63, 64
external side-chain processing 20
Extra Long Delay plug-in 69

F
favorites 12

Feedback control 72, 80, 81, 82
File Mode selector 34

Fine control 72

Flanger plug-in 80

flattening a track 84

Frequency control 71

Frequency Graph display (EQ Ill) 43

G

Gain control 81

Gain plug-in 86

Gate Il 65

Gating control 65
Graph control 64, 65

H
Hall algorithm 60
Hardware 12
Hardware Buffer Size 8
Harmonic 12
HD-series cards
DSP delays 99
Hi Frequency Cut control 61



High-Pass Filter control 81
Hold control 65, 66
host processing 1

I
Import Settings command 24
importing plug-in settings 26
Increment Patch 27
Input Level control 82
Insert Position selector 16
inserting plug-ins during playback 14
inserts 11

post-disk 11

pre-fader 11

pre-fader operation 11
Instrument 12
internal side-chain processing 20
Invert plug-in 83
inverting gain (EQ 1) 42

K
key input 20
definition 20
HPF control 67
Key Input selector 17
LPF control 67
using for external side-chain
processing 21
Key Input selector 21, 36
Key Listen control 21, 63, 64
keyboard shortcuts 20
Knee control 63

L
latency

and RTAS 8
Level control 71
LFE Enable button 18, 63, 64, 67
LFO Rate control 80, 81
LFO Waveform control 80, 81
LFO Width control 80, 81
Librarian menu 16
Limiter Il 63
Link Enable buttons 17
linking plug-in controls 19

Lock Settings File command 24

locked regions and AudioSuite processing 39

Long Delay plug-in 69
Low-Pass Filter control 61, 80

Manufacturer 12
Master Faders

inserting RTAS plug-ins 29
Master Link button 17
Max Peak At control 85
Maximum Pitch control 73
Medium Delay 69
MIDI Beat Clock 21, 69
MIDI Output selector 93
Minimum Pitch control 73, 88, 89
Mix control 80, 82
Mod Delay I

Tempo Sync 22
Mod Delay Il plug-ins 69
Mod Delay plug-ins 68
Modulation 12
mono plug-ins 11
moving inserts 14
multi-channel plug-ins 12
multi-mono plug-ins 11
MultiShell Il compatible plug-ins 8
Multi-Tap Delay plug-in 81

muted regions and AudioSuite processing 39

N

Noise Reduction 12
Noise Shaping 57, 58
non-real-time plug-ins 31
Normalize plug-in 85
Note control 90

(0)

opening multiple plug-in windows 18
ordering RTAS and TDM plug-ins 30
Other 12

output bit resolution for Dither plug-in 57

Output Meter 59
Overwrite File command 34

Index
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P

Pan control 82
Paste Settings command 24
pasting plug-in settings 26
Peak On All Chans/Tracks mode 35
Peak On All Tracks mode 85
Peak On Each Chan/Track mode 35
Peak On Each Track mode 85
phase cancellation 75
Phase Invert button 17, 62, 74
Ping-Pong Delay plug-in 82
pink noise 71
Pitch plug-in 71
Pitch Shift 12
Pitch Shift plug-in 89
Pitch transposition 71
Playlist command 33
plug-in controls
adjusting 19
linking 19
Plug-In selector
for AudioSuite plug-ins 32
for real-time plug-ins 16
plug-in settings librarian 24, 36
Plug-In window 16
closing multiple windows 18
opening multiple windows 18
plug-in-induced delays 10
plug-ins
as Inserts 11
auditioning settings 27
automating 22
creating a default setting 26
inserting 13
inserting during playback 14
inserting on-the-fly 14
Manufacturer view 12
mono 11
moving and duplicating 14
multichannel 12
multi-mono 11
removing 14
post-disk inserts 11
POW-r Dither plug-in 58
Pre-delay control 61
pre-fader inserts 11
previewing AudioSuite effects 35
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Process Mode selector 34
processing
AudioSuite 35
multichannel for AudioSuite 36
preferences 37
requirements of real-time plug-ins 7

R

Range control 65, 66

Ratio control 62, 72, 88, 89

real-time plug-ins 7

recording with plug-in effects 11

Reduction meter 62, 66

Reference Pitch control 90

Region by Region mode 34

Region List command 33

Relative Pitch Entry 72

Release control 62, 64

Reverb 12

Reverse plug-in 86

ReWire
and voices 92
plug-in description file 93
track count 92

Root Settings folder 24
specifying 25

RTAS plug-ins 1
additional latency 29
improving performance 8
ordering with TDM plug-ins 30
placing after TDM plug-ins 29
placing on Auxiliary Inputs or Master Faders 29
voice usage 29

S
saving plug-in settings 25
Save Plug-In Settings To command 25
Save Settings As command 24
Save Settings command 24
screen response 8
selecting tracks for AudioSuite processing 39
Selection Reference selector 33
Set As User Default command 25
Set Plug-In Default To command 25
Set Root Settings Folder command 25
settings 17, 36



choosing a destination for 25
copying 26
creating subfolders 26
creating User Default 26
importing 26
pasting 26
saving 25
Settings Preferences command 25
Settings menu 16
Short Delay plug-in 69
shortcuts for keyboard input 20
sibilants 67
side-chain
definition 20
filters 21
processing 17
Side-Chain Listen 21
side-chain processing 20
Signal control 71
signal delay 99
Signal Generator plug-in 70, 86
Signal Present Indicator 72
Size control 60
Slap Delay plug-in 69
Sound Field 12
Source and Destination controls 87
subfolders, creating for settings 26
System Usage window 98
RTAS 8
DM 7

T

Target button 17

TC/E control 38

TDM plug-ins 1, 7
DSP requirements 95
inserting on tracks 13
moving and duplicating 14
ordering with RTAS plug-ins 30
removing from tracks 14

tempo
Tempo Sync 21

Tempo Sync 18, 21, 69
Mod Delay Il 69

Threshold control 62

through-zero flanging 80

Time Compression/Expansion plug-in 87

Time Correction control 89
Time Trimmer 38
TimeAdjuster plug-in 73
using for delay compensation 9
Track selector 16
tracks
affect of RTAS 8
Trim plug-in 76

U

unlinking plug-in controls 19

Use in Playlist button 33

User Default setting, creating 26

Vv

voices
and ReWire 92
and RTAS 8, 29

w
Web site 3
white noise 71
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